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1 Basics

1.1 Introduction

Remark:

The user manual describes the functions of the Belimo PC- Tool. The Belimo
PC-Tool is a PC-based tool for parameterizing Belimo MFT(2), MP, MF, LON and
BF-TopLine actuators, MFT(2), MP and BF-TopLine actuators can be configured
for MP-Bus operation and can be monitored via bus.

This document is designed to present basic information. Since the PC-Tool has a
modular structure, the explanations for specific modules are given in the
individual module documents.

The documentation of the individual modules can be accessed through the main
document.

1.2 Information on using the manual

Variant

An arrow symbol shows the order of menu commands in sub-menus. For the
function

MP-Channel » Trigger scan,
select MP-Channel in the main menu and then Trigger scan in the submenu.

This manual uses English terms for control elements frequently encountered in
Microsoft Windows:

Button

Combobox

Radio button

Checkbox

Notes are enclosed in separation lines.

If a function can be triggered in several ways, variant ways are described in
addition to the recommended way.
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1.3 General structure of the user interface

=101 =]
File Project MP Channel Tools H A
—

De3| 2|t w6l (e [F] :~:;|E»|g B
B-~amr] L Tool V.0 Tyme NM2Z4-MFT2 SN 00449-20025-062-069
o ? et A Designation NM24-MFT2 Address MP1
""" - annel = o
1 # MPY: Rooml, Position Rooml
Ll MPZ: Boom?,

. Simulation | |E|

C Actual S ettings = Test |
Control function” DC 2-10V
Sengitivity Mormal Adaption |

Synchronisation

Service | Configuration

Hominalrange 93.72°
Running time 80s
Angle of rotation Maw 100 [947] . . "
:BlE
Wir: 0% 0] Mid.: 50 [47°] |
Direction of rotation cw é‘ﬁ
Synchronisation at v=0% 1003

Torque 100%
Bus fail position Analog setpaint
Power ON HMathing
M anual button [once] Synchronisation
Manual button [twace] Adaption ;I

——

4| I _;I State: IEI 0
User interface PC-Tool

“=———=——"_ whole. An explanatory text (tooltip) appears for each icon in the toolbar when you

[Parameterize Limited Lot POSItion the mouse pointer on it.
The MP-Channels and actuators belonging to the project are displayed in the
outline bar [C] in the form of a tree (as in the Explorer). The object to be worked
on is marked here. Depending on the selected object, pop-up menus offer
corresponding functions at a click of the right mouse button.

E! e | eee | J53| S Menu bar [A] and toolbar [B] provide functions that affect the program as a

----- § ' Change MP-Address
---- - Nie De-.ﬁ.ddressing device

Print |abel
Prinkt parameter set

Pop-up menu after clicking the right mouse button

The detail area [D] contains all the detailed information on the object marked. The
values that are displayed and changed in this area are grouped as needed and
distributed over several index tabs.

The status bar [E] at the lower margin shows the current status of the connected
device (e.g.: the actuator is carrying out a synchronization or adaptation.)

5/51



T
PC-Tool V3.6 General part, user manual BEL'MO

Missing or invalid entries are indicated by a flashing exclamation mark. If you
move the mouse pointer to the exclamation mark, an explanatory text (tooltip)

appears.
Froject: I [ | |
| This Field is required |
Tl Inactive commands are displayed in gray letters (or as gray icons) according to
" = the Windows standard.

Texts in boxes with a black font on a gray background cannot be changed. You
can mark the contents with the mouse, however, and copy them into the
clipboard with CTRL+C, for example.

IMesssignaI 115 variabel

1.4 Modules and actuator types

Multifunctional damper actuators
The following actuator types can be parameterized with the program PC-Tool:

Generation | Type MP-bus Sensors

NEW MP YES active, passive, switch
MPL YES (see datasheet)
MF No (none)

OoLD MFT2 YES active, passive, switch
MFT YES active, switch
BF..24TL.. YES (none)

The manual is organized according to the application areas for actuators
(modules). Detailed descriptions can be found in the module-specific sections,
e.g. Air module, Water module, Fire & Smoke module, VAV module, EPIV
Module.

VAV controller

The VAV module (VAV = Variable Air Volume) is for operating and
parameterizing the Belimo VAV-Compact controller xMV-D2-MP.
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2 Getting started with PC-Tool

2.1 Connecting the computer with the actuators

Connect the level converter ZIP-USB-MP to your computer. The connection of
the actuators to the ZIP box is explained in the Appendix. If you use a different
interface than COM1, you must subsequently adapt the setting [= 3.3.1 Serial
interface].

For typical wiring diagrams, see = 4.4 Typical wiring diagrams

2.2 Starting the program

i

BELIMO PC-Toal 3.0 Click the program icon on your desktop. A start screen appears. Click Start
Belimo PC-Tool (bottom right).

2.3 Adapting PC-Tool options

When you start the program for the first time, a dialog is displayed for adapting
the user-specific settings.

= PC-Tool Options

General . )
Folease Codes Project base path:

MP channel configuration |Wheh s barafch$ B elimatPCT ool

Air module [~ Use default
Water Globe module 58 feau

Wl WY-D2M module

W Compact module Language:
Wi WYRP-M module - Thi I ting b K
/ E halizh - e new language setting becomes active
Fire & Smaoke module | nai after a program restart.
EPFIY module .
Log file:

" File per week * File per month
[ Enable MP-tonitor
Simulation,/Trend

[ Ask user if trendfiles should be saved [if not check save them alwaps).

[¥ Enable sensor reading functionaliby

Cancel

PC-Tool options

Select the desired language in the combobox here. If you change the language,
exit the program and restart it.
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2.4 Creating a new project

To work with the program, you have to create a "project". The dialog for entering
the project data is displayed. Click the radio button "New project".

MNew/Open projct

™ Existing project | & MHew project
Project | Con
EPMQ Project: I
=] ACME
Compary: I
Short-M ark: I
Commet:
[ i
IzerD: I
Szarsh. | Froject path: IE:HDatenHBeIimn\F‘ETDDI |

k. I Cancel ,L
.#

Creating a new project

The project name, company and user ID must be filled in; all other information is
optional.

2.5 Setting up the program

The project and the MP-Channel can be seen in the outline bar [C]. The bus is
scanned every 10 seconds by default.

i PCTool v3.0

2 Project: ACME
% MP-Channel: COM=4, (MP/PF, Every 10s)
b A2 MPT: Rooml, MM24-MFT 2, Inlet darper

- & MPZ FoomZ, MM24-MFT 2, Heater valve

Outline bar [C]

If no actuators are shown after 10 seconds, you should check whether the level
converter ZIP-USB-MP is connected to the right COM interface. Adjust the
settings for the serial interface if necessary [ 3.3.1].
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2.6 Displaying actuator parameters

Select the desired actuator in the outline bar [C] by clicking it with the mouse.

The current settings for the actuator are displayed in the detail area [D].

Type MM24-MFT2 S 00448-20025-062-069
Designation Inlet damper Address MP1
Position Room|

Service | Configuration | *. Simulation

Actual 5ettings 1= Test

Control functiony DC 2-10%
Senszitivitp Momal

Adaption

Nominalrange 9372° Synchronisation

Running time 20:
Angle of rotation Max 100%  [947] . . .
ol
Mire 0% (0 hid.: &0 [47°] L
Direction of rotabon cw él‘ﬁ
Synchronmsation at v'=0% 005

Torque 100%
Bus fail position Analog zetpoint
Power ON Maothing
Manual button [once] Synchronization
Manual button [wace] Adaption LI

Example of detail area [D] (damper actuator)

2.7 Further actions

Read the descriptions for the following topics in Section 3 Basic functions

= Bus scan

= Setting the bus address

= Parameterization of actuators

Read the details for the application areas of the actuators in the descriptions of
the following modules

= Damper actuators (Air module)

= VAV controllers

= Actuators for fire & smoke dampers (Fire & Smoke module)

= Valve actuators (Water module)
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3 Basic functions

3.1 Program start

Variant

After the program is started, a start screen is displayed. Click Start.

Determine the project with which you would like to work. You can either
= open one of the last projects listed,

= open an existing project from a file, or

= create a new project.

The defined MP-Channel is displayed and opened. A bus scan is started for each
MP-Channel.

If only one actuator is connected, it is automatically selected and displayed.

If you cancel the project selection, the program will be started without a project. In
this case, only the functions Help, File» New project and File » Open existing
project will be available.

You can also start the program by means of opening a project file: In the
Explorer, double-click a file with the extension .bptpj or on a corresponding file
link.

If you create a link to a project file on the desktop, make sure that you do not
inadvertently move or copy the file instead. You can tell when a link has been
created correctly by the small arrow in the bottom left-hand corner of the file icon.
(If the project file itself, rather than a link to it, is on the desktop then all other files
will be saved there as well.)

In a network environment, the program should be installed on your workstation
and started locally. Special authorizations are required to start the program on
network drives.
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3.2 Projects
3.2.1 Project data

All user-specific data of the program are administered in the framework of
projects. Each project has a project directory in the file system. The project files
are stored in sub-directories of the project directory.

The storage place of the project files is described in the Appendix.

3.2.2 Creating a new project

Select File », New Project in the main menu. Enter the new project data in the
dialog. The project name, company and user ID must be filled in; all other
information is optional. Click OK.

Since only one project can be active at a time, the currently displayed project will
be closed and the new project opened.

Variant ~ You can also create a new project by clicking the New Project icon on the
QI toolbar [B] or clicking the program icon in the outline bar [C] with the right mouse
button and then selecting New Project.

- PLCT ool 3.0

3.2.3 Opening a project
Select File » Open Existing Project in the main menu. A list of all project files in
the storage location is displayed.

Mark a project from the list in the dialog or open any given project file (* .bptp3j)
with Find.... Click OK.

Since only one project can be active at a time, the currently displayed project will
be closed and the selected project opened instead.

Variant  You can also create a project by clicking on the New Project icon on the toolbar
|E| [B] or clicking the program icon in the outline bar [C] with the right mouse button
and then selecting Open Project.

| PCT ool V3.0

3.2.4 Changing project data
Click the project in the outline bar [C] to display the project data. The Edit button
(far right) displays a dialog in which you can change the data.

Variant  Click the project in the outline bar [C] with the right mouse button and select
Properties.

Project name and path cannot be changed within the program. However, you can
rename the project file (extension .bptpj) using the Windows Explorer or move
the entire project folder to another location. Afterwards, open the project again.

11 /51



T
PC-Tool V3.6 General part, user manual BEL'MO

The project folder and project file can have different names — for example for
backing up data. The name of the project file determines the project name.

3.2.5 Exporting a project

Copy the entire project folder in the Explorer, for example onto a floppy disk.

3.2.6 Copying a project

Copy the entire project folder to another location in the Explorer. Give the project
folder a new name. Give the project file (<project>.bptpj) the same name within
the new project folder.

3.2.7 Deleting a project

Delete the entire project folder in the Explorer. The project to be deleted must not
be currently open in the program.

3.3 MP-Channel

3.3.1 Serial interface

The ZIP level converter is connected to a serial interface (COM) for connecting
- the MP/MFT(2) actuator or the MP-Bus to the PC-Tool. To select the number of
- MP-Shang: the serial interface used on your computer, click the MP-Channel icon in the
outline bar [C] and select MP-Channel settings.

For typical wiring diagrams, see = 4.4 Typical wiring diagrams

Now set the serial connection:

= |f you activate the "Serial connection" box (as shown in the screenshot), you
can select a serial connection. This list shows all ports on your computer
(between COM=1 ... COM=255).

= Option: If you activate the "Other" box, you can enter a connection ID in the
text box. Valid values are:

"COMXx" or "COM:x" or "COM=x" (x is is the port number between 1 and 255).
"Baudrate=x" (x is the baud rate 75...115200).

"Bytesize=x" (x is the number of data bits 5...8).

"Stopbits=x" (x is the number of stopbits 1, 1.5 or 2).

"Parity=x" (X is the the parity no, odd, even, mark or space).

It is only mandatory for the COM port to be specified. Separate the values with
a semicolon (}).

Example:
"COML1;Baudrate=9600;Stopbits=1".
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3.3.2 Bus scan

W=
— Connection
' Sernial connection IEEIM=4 j
" Other I
—Buz zcan
Scan Interval [2] I 10
Scan Mode [MP/PP =]
k. || Cancel I

MP-Channel settings

In the bus scan section of the "MP-Channel settings" dialog, you can enter the
time interval for the periodic bus scan in seconds. Permitted values are whole
numbers between 1 and 9999.

The program can address actuators in two basic ways:

In multi-point mode (MP), up to 8 actuators of the types MP / MFT(2) can be
individually digitally addressed.

In point-to-point mode (PP) only a single actuator can be activated. In this case,
the "classic" operating modes are available with response voltage at connection
D5.

The actuators of the MF type can only be connected in PP mode, all others either
in PP or MP mode.

Select the type of bus scan in the bus scan section of the
"MP-Channel settings"dialog:

PP Only Connection of a single actuator in PP mode

MP / PP First scan address 1 to 8 in MP mode.
If there is no response in MP mode, switch to PP mode.

Periodic bus scan

The periodic bus scan is active by default. To switch this off, click the MP-
Channel with the right mouse button and select Interrupt scanning. Afterwards,
you can switch the periodic scan back on again the same way with the menu item
Scan Every xx Seconds.

Manual bus scan

Manually activate an immediate bus scan with the function button F5 ("Update™)
as needed. This is possible at any time, even when the periodic bus scan is
active.
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Variant  You can also select MP-Channel » Trigger Scan in the main menu or activate
the Trigger scan function by clicking the MP-Channel with the right mouse button.

If more than one actuator responds at the same MP address during a bus scan or
if more than one actuator is connected in PP mode, a bus jam will occur. This
situation is indicated by the program with a corresponding message.

=] PCT ool Y3.0 Bus Kollisi
[Fewes Projekt] Projekt: ACME us Kollision
= MPStang COM=1, [F| 2 oder mehr Teilnehmer antworten auf der gleichen Adiesse

o gl PP B Eaollision

Saving a bus scan overview in a file

The result of a bus scan can be saved in a file for recording. Select "Channel" in
the outline bar to show an enumeration of all found MP nodes with the
corresponding data (address, position, type, description and serial number).

R PC-Tool -—-- BELIMO Automation AG 3 =10f x|
File MP-Monitor Project Channel Tools Help

D||@| 21 @] &b
—| == PCToolGUI V3.4
[ Project Standard

= .—-7‘ Channel: COM=2, (MP/PI Address | Positionl Typel Designation| Series No.
MP1: test rig, LR24¢ & MP1 testrig LR.. ACME 00633-20177-142-136
g
& MP3: testrig, LM24s i e S Sl 00543-10256-142-143
| Save to file... |
<] | »]
<] | i

Saving the bus scan overview

Click the right mouse button to open the context menu and choose "Save to file"
for saving the information in a text file.

3.4 Setting the bus address

Each actuator with an MP-Bus interface (valid for all devices with an MP-Bus
interface, e.g. I/0 modules, etc.) can be assigned an address which it will use to
communicate on the MP-Bus.

The setting of the bus address can be disabled on certain actuators, e.g. for the
actuator types ...LON and ...ALON (for LONWORKS®).

3.4.1 Series addressing of actuators
|EI Click the Address device icon in the toolbar [B].

Variant  Click the MP-Channel with the right mouse button and select Addressing Device.
Or select MP-Channel » Addressing Device in the main menu.
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Series addressing of devices

Seniez-Mumber of the device

& [P0443-20025-082-063

& |00323-10038-082.076

Insert zeries number of devices manually or read the senesz number of the devices by actuating the manual buttan, L/R

awitch or 52 button.

Set Address I

Series addressing

Type of the device
MM24-FT 2
Mt 24-MFT 2

Address

T = I ZZIZIZIE
ol My oy o) o) | o m
wm| | ;o A &= W | =
4 4 4 4 4 4 4 4

e
BELIMO

Cancel |

If you want to use something other than the default order, then select the desired
addresses in the comboboxes on the right.

Reading in the serial numbers with acknowledgement on the actuator

Then press the acknowledge button on the actuator that is to receive the first
address. Depending on the type of actuator, this is the manual button, the L/R
change-over switch, the manual control or the S2 button. (If the buttons are not
accessible, enter the serial numbers directly as described below.)

Actuator family

Actuator type

Acknowledge function

Actuators
without
spring return

NM24-MFT(2)
AM24-MFT(2)
GM24-MFT(2)

Press manual button once!

Actuators with
spring return

LF24-MFT(2)
AF24-MFT(2)

Move L/R switch back and forth once

(within 4 seconds)!

2, )
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Actuators for BF(G)24TL-T-ST | Turn the manual control for about 1/6 in
fire & smoke direction "Unlock" r¥ and release the crank.
dampers

(&)
Linear NV24-MFT(2) Actuate button S2 (under the housing
actuators for NVF24-MFT(2) |cover) once! *
valves NVF24-MFT(2)-E iz}
Actuators of ...MP Actuate the "Address" button
the New ..MF
Generation ...ALON

The serial number of the actuator is read out after the acknowledgement and
written into the input box. The cursor jumps to the next line.

Repeat this process for all actuators that are to be addressed and then click
"Set address".

If one of the addresses is already assigned to another actuator, a message will
be displayed:

Belimo PC-Tool: Series addressing of d x|

@ Address MP1 is nok free, de-address other devicels) Firsk?

Mo | Cancel |

Message when an address is already assigned (series addressing)

Click Yes to initially release the address. The actuator that used to occupy the
address is set to PP.

If you select No, the actuator will be set to the already assigned address and a
bus jam can occur.

Click Cancel to stop the series addressing at this point. You can now rearrange
the addresses or end the entire process.

3.4.2 Addressing with known serial numbers

Each MP/MFT(2) actuator is delivered with a label containing its individual serial
number. These serial numbers can be used to assign a PP or an MP1 ... MP8
address to the actuator. An additional, removable label with an identical serial
number is supplied with the actuator. If the actuator is installed at a particular
position in the system, this additional label can be affixed at the same position in
the system diagram. This records where the actuator with the corresponding
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serial number is located in the building. These serial numbers can be used to

assign the MP1 ... MP8 addresses to the actuators.

You can also fill in the input boxes manually before clicking Set Address, for
example when the buttons of the actuators are not accessible or you regularly

take the serial numbers from your documents.

3.4.3 Resetting actuator addresses

If you want to reset actuators with MP addressing to PP, click to the right of the

MP-Channel and select "De-address Device" in the pop-up menu.

De-Addressing

—Addreszes ta rezet to PP-Mode

W 1P
[~ MP2
[~ MP3
[~ MP4
[~ MF5
[~ MPB
[~ MF7
[~ MP3

De-Address

Cancel

Selection of the addresses to be reset

Mark the addresses whose actuators are to be de-addressed.
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When the bus scan is set to MP/PP, the de-addressed actuators are no longer
visible in the outline bar [C] as long as there are still actuators with addresses.

If you set several actuators to PP, a bus jam will occur with the bus setting
"PP only".

3.4.4 Addressing a single actuator

Variant

Select the actuator in the outline bar [C] and click the "Change MP Address" icon
in the toolbar [B].

Set new address

Old address:  MP1
MP3

Mew address:

Set Address I Cancel |

Setting a new address

Click the actuator with the right mouse button and select "Change MP Address"
("MP-Adresse andern").

Select the new address in the combobox. If the address is already assigned to
another actuator, a message will be displayed:

Belimo PC-Tool: Addressing of device |

@ Address MPZ is not free, de-address other devicels) first?

Yes Mo |

Message when an address is already assigned

Click Yes to initially release the address. The actuator that used to occupy the
address is set to PP.

If you select No, the actuator will be set to the already assigned address and a
bus jam can occur.
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3.5 Selecting a module

All actuators that are active and connected to an MP-Channel are displayed in
the outline bar [C]. Select the desired actuator from this display.

B r;g‘ tMP-Channel: COM=4, [MP/PP, Evern 10s]
------- ,59 FP1: Foomd, MiZ24-MF T2, [nlet damper
bl 4P WPZ FoomZ, NM24-MFT2, Heater valve

The type of actuator is indicated by the icon:

Icon Actuator type

Damper actuator

Valve actuator

Window ventilation actuator

3 Actuator for fire dampers

VAV (Variable Air Volume) controller actuator

THC24-MP

ENENREHEIEIR

UST-3 I/0O module

EPIV Electronic Pressure Independent Valve

m
3
=

Unknown actuator

H

When an actuator is selected for the first time, the parameters are read out and
displayed in the detail area [D].

In addition, the address for communication on the MP-Channel (MP or PP mode)
and the name of the actuator type are displayed in the outline bar [C].

The complete information for identifying the selected actuator is found in the
header of the detail area [D].

Type NM24-MFT2 Sk 00449-20025-062-069

DCesignation Inlet damper Address MP1
Fosition Room1

Display of the actuator identification

Note the difference between the current communication mode on the MP-
Channel and the displayed address. An actuator with the address MP2 can be
activated in PP mode during a bus scan, for example.
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3.6 Actuator parameters

3.6.1 Displaying actuator parameters

The parameters of an actuator are displayed on the Service tab in the
detail area [D].

Type NM24-MFT2 Sh 00449-20025-062-069
Designation Inlet damper Address MP1
Fosition Room1

el

Service Configuration| *. Simulation

Actual Settingz = Test

Control functionY DC 2100
Sensitivily Mormal Adaption

Synchronisation

Hominalrange 93.72°
Running ime 80=

Angle of rotation Max 100% [347]
bl 13 1

Mid.: 50%  [47] L

Example of the "Service" tab (damper actuator)

The Test, Adaptation and Synchronization functions are described for each
respective module.

3.6.2 Printing out actuator parameters

The displayed actuator parameters can be printed out. Click the printer icon in the
toolbar [B] or select Print Actuator Parameters in the pop-up menu after clicking
the actuator in the outline bar [C] with the right mouse button.

3.6.3 Deleting maintenance/error messages

When an actuator has created and saved maintenance or fault messages, these
are displayed on the Service tab.

Messages

Messages Mechanical travel increased
Reset Messages

Message display on the Service tab

Use "Reset messages", to delete the messages stored in the actuator.
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Following messages may appeatr:
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Message

Description

Mechanical travel increased

Expected end stop value for top or bottom
has been overrun.

Mechanical overload

Actuator did not reach set point because an
obstacle has reduced the operating range

Excessive utilisation

Actuator moves to often compared with the
total operating time

(typical relation of active time to operating
time is greater than 20%)

Fail-Safe failed

The Fail-Safe module is defect (e.g Super
Cap module). This message cannot be
deleted. The defect actuator has to be
replaced.

Actuators for fire & smoke dampers have provide a larger scale of messages.
The specific messages are described in the Fire & Smoke module.
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3.7 Configuring an actuator

To change the parameters of an actuator, go to the Configuration tab.

Type NM24-MFT2 S 00449-20025-062-069
Designation Inlet damper Address MP1
Fosition Room1

Service Configuration ', Simulation

Designation Ilnlet damper

Poszition IHDDITFI

Start Stop
Control signalY |DC 210 =l
Read
Min Mid b Write
Angle of rotation I 0 Z[0.E7%] I B0 E[0.100%] I 100 % [33.100%)
I_Do I_‘W I_S“ Store tofile...
Runningtime [ 80 s (74.2365) Load from file_.

Example of the "Configuration" tab (damper actuator)

The lower area with the basic settings can be displayed with the "More..." button
and hidden again with the "Less" button.

When you change a value in an input box, the box turns yellow:
ki
Drehwinke 10 % [0.B1%]

The status image on the right additionally shows whether all the displayed values
match those stored in the actuator:

@ ]/fﬁ)

Display matches actuator Values have been changed

Status image
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Save the changed values in the actuator with the "Set" button underneath the
status image.

You can read out the parameters currently saved in the actuator again with the
"Read" button. Entries for values that you have not previously saved in the
actuator will be lost as a result.

3.7.1 Saving a parameter file

You can store the displayed parameters in a file (with the extension .bptpar) with
"Store to file..." on the "Configuration” tab. The suggested name for the file
consists of the project, the actuator type, the position, the serial number, the
current date and the time of day.

Since the content of the file corresponds to the values displayed on the screen,
you can change individual values and save variants in files without loading them
on the actuator.

The file can only be saved when all values on the screen are valid.

3.7.2 Loading a parameter file

The values of a saved parameter file can be read back into the input screen for
the configuration with "Load from file...".

3.7.3 Copying parameters

Read out the parameters of an actuator that you want to copy and save them in a
file. Change the actuator, load the saved parameters from the file and program
the actuator with the copied values.

3.7.4 Load factory settings

When a project is created, two folders are created in the parameter directory.
These folders contain the factory settings for all supported actuator types.

|_;lpa|ameterfiles ﬂ = £ E-

) factory settings air
) factory settings water
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| |3 factory settings water
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- e @B

] AV24LON. bptpar
] AV24LON-R.bptpar

~] GR24A4MF-5.bptpar

~] GR24A4MP-5.bptpar
=

o] ) —|bptpar
— Typ: Belimo PC-Tool V3.0 Resource File

AV Geandert am: 29.09.2006 13:10 potpar
=| AV Grafe: 117 KB bptpar

[~ AVIEFT IR I05.bptpar
] AV24-MFT.bptpar

] AV24-MFT-R.bptpar

] AVY24-MFT bptpar

] AVY24-MFT-C105.bptpar
] AVY 24MFT-R.bptpar

] AVY 24-MFT-R-C105.bptpar
] GM24A-MF. bptpar

~] GR24ALON-5.bptpar

~] GR24ALON-7.bptpar

£

=[IRUZ3EF . bptpar

~] NRU24A-MF bptpar

-~ NV24LOM. bptpar

| NV24-MFT 2.bptpar

| Y 24-MFT bptpar

| NV 24-MFT-C 103.bptpar
] Ny 24MFT-T.bptpar

-~ NVF24L0N. bptpar

] NVF24LON-E.bptpar

=] NVF24-MFT 2.bptpar

] NVF 24-4VFT2-E. bptpar
| NVF 24-4VFT.bptpar

| NVF 24-MFTE. bptpar
=] NVF 244MFT-E-T biptpar
] NVF 24-MFT-T. bptpar
] NVG24LON.bptpar

-~ NVG24-MFT 2. bptpar
[~ NVG24-MFT. bptpar

| NVG24-MFT-T.bptpar
] VY 244VF T bptpar

] V¥ 24-MFT-C 105.bptp
] VY 24-MFT-R.bptpar
] MY 24-MFT-T. bptpar
~] SR24ALON.bptpar

-~ SR24A-MF-5.bptpar
»

Dateiname: |

Dateityp:

|Belim|:| Farameterdatei [~ bptpar)

Parameter files with factory settings

j Offnen |
ﬂ Abbrechen

Open the file which matches the actuator type. The settings are loaded into the

input screen for the configuration. Afterwards, store the parameters in the

actuator with the "Set" button.
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3.8 Parameterizing limited lots

Ed

Variant

You can parameterize several identical actuators with the function "Parameterize
Limited Lots". The number depends on the power of the voltage supply.

To parameterize limited lots, save the parameter set to be programmed in a file.

With one parameter set, you can only program actuators from the same actuator
family (e.g. MFT or NMV), i.e. the parameter set used must match the actuator

family.

Connect the devices according to the following wiring diagram (for further wiring
diagrams, see clause 4.4 Typical wiring diagrams):

. BELIMO
Belimo " g
PC-Tool - g oo 3 Speisung
© et a Power Supply
= AC/DC 24V
[\ ZP-USBMP  ce
— usB GND 24V
ZK2-GEN white/weiss = GND
blue/blau = 24V
green/griin = MP
" "Q@""Qﬁ:fﬁ"
MP
PS Py
....A-MP ....A-MP ....A-MP ....A-MP ....A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
SMFTE) || ovFTE) || MFTE) || MFT@) || MFT@) || ..MFT(2)

Select the desired MP-Channel and click the symbol "Parameterize Limited Lots".

Click with the right mouse button on the MP-Channel and select Parameterize
Limited Lots. Or select the MP-Channel » Parameterize Limited Lots in the main

menu.

25 /51




y - 4
PC-Tool V3.6 General part, user manual BEL'MG

Parameterize Limited Lots

Parameter file: II:Il:l44S-EDDEE-UEE-UEEI_EDUEDEE'I_'I 340.bptpar j
Sernes Number | State

004439-20025-062-059

00329-10026-062-076

Inzert zenesz number of devices manually or by actuate manual Button, L/R switch or 52 button.

¥ Frint Label FParameterize I Cloze

Dialog for parameterizing limited lots

Select the file with the saved parameters in the dialog.

Position the cursor in the first input box for the serial number. Then press the
acknowledge button on the first actuator which should be parameterized. If the
buttons are not accessible, directly enter the serial numbers as described below.

The serial number of the actuator is read out after the acknowledgement and
written into the input box. The cursor jumps to the next line.

Repeat the process for all actuators that are to be parameterized and mark the
checkbox if you want to print labels after parameterization
(see Section 3.9 "Printing labels").

Click Parameterize.
The PC-Tool now asks for the file with the values to be written into the actuators.

The periodic bus scan is stopped for the duration of the parameterization. The
actuators are successively set to the address MP1, programmed and finally set to
PP addressing.

When the bus scan is set to MP/PP, the actuators in the outline bar [C] will not be
visible. If the bus setting PP Only is used, a bus jam will result.

If an error occurs during programming, a corresponding text is displayed in the
"State" column.
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If the address MP1 is already assigned to an actuator, a message will be
displayed:

Belimo PC-Tool: Parameterize limited lo El

@ Bddress MP1 is nok free, de-address ather device(s) First?

Cancel |

Message when the address MPL1 is already assigned (limited lot)

Click OK to initially release the address MP1. The actuator that used to be
assigned to this address will be set to PP.

Click Cancel to stop the parameterization at this point.

Identification with known serial numbers

You can also fill in the input boxes manually before you click "Parameterize", for
example when the buttons of the actuator are not accessible or you regularly take
the serial numbers from your documents.

Programming further series

The actuators that have been successfully programmed are deleted from the list.
You can register further serial numbers in the list and then click "Start
parameterization" again.
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3.9 Printing labels
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To identify actuators, you can write self-adhesive labels with the PC-Tool
program. A special printer may be necessary, depending on the type of label.

3.9.1 Setting up a configuration file

Labels are defined per project. To print labels, set place holders (number in
brackets) in the configuration file for the information to be printed.

The structure and storage location of the configuration files are described in the

Appendix.

3.9.2 Printing labels

|EI Select an actuator and click the "Print Label" icon (with an orange background).

Variant  Click an actuator in the outline bar [C] with the right mouse button and select

"Label Printing".

E Label Printing

Printer selection |‘x‘xL| RAMNOS Mirwana

MNumber of labels per actuator 1 El:

Mext printable label on sheet 1E|:

Label configuration file [Avery 5162 bt =]

Label print oder: a) left to nght b) top
to bottom.

o

L

LU b

Tagging string (47) |Number #

Start number 13:

[To number the actustors in senal order, place the T
charactor into the tagging string).

Lable string [42) |F||:u:|r I

Lable string (43) |

Lable string (4£4) |

Reset Form |

Print Preview | Erint | Cancel

Label printing dialog
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Select a printer and a configuration file.

Enter the number of identical labels that are to be printed for "Number of labels
per actuator”". When parameterizing limited lots, the total number of printed labels
is equal to this value times the number of actuators.

Enter the desired texts {41} — {44} that are to be printed, if necessary. A
maximum of 50 characters are available per text box. In text with consecutive
numbering, a number is entered instead of the place holder "#". This number is
increased by one for each new actuator.

If labels have already been used from a label sheet, you can specify at what label
position the printing should start (for example 4 when 3 labels have been used
from the first row).

Your entries and the selected printer are preserved from one label printing
process to the next (automatic saving). You can empty the input boxes with
Reset Form.

The texts {41} — {44} must be present in the label configuration file in the form of
place holders. Otherwise, they will not be printed out.

3.9.3 Printing labels offline

il

Variant

Labels can still be printed even if no actuator is connected. In this case, only the
information from the project data, the texts entered in the dialog and the current
date can be output. The start number is always used instead of the place

holder #.

Click the "Print label" icon (with gray background).
Click the project in the outline bar [C] with the right mouse button and select
"Label Printing". Or select Project » Print Label in the main menu.

For Number of labels per actuator, enter the number of identical labels to be
printed. The number with the placeholder "#" is NOT counted up. The further
procedure is the same for printing actuator labels.

3.10 Transformation tables

Transformation tables are for converting the sensor value into another physical
quantity, for example from resistance (in ohms) to temperature (in °C) for NTC
resistors. Several frequently used transformation tables are supplied with the
program.

Selecting a transformation table

Select a transformation table with the combobox. The corresponding converted
value is displayed underneath the sensor value.

The measured sensor variable in the table must match the selected sensor type:
volts for active sensors, ohms for sensor resistors, on/off for switches.
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L2

Variant

Adapting a transformation table
Click the transformation table icon.

Click the project in the outline bar [C] with the right mouse button and select
Transformation table. Or select Project » Transformation table in the main menu.

=Edit Transformation Table - O] x|
[ | = | El Mi_1000. byttt

Fram To Drescription:
[ohm  =||T  +] [Mi-1000 Ohm to * C
Obm 2 | L -
» 743 0 . 190
79 -40 .
842 -30
893 -20 100
946 10 T
1000 0 50
1056 10 .
1112 20 0
1141 25
1171 0 i
1230 40 50 t T T
1291 B0 R00 1000 1500 2000
1353 = Uhm
1417 70
1483 a0l o

Cloze |

Dialog for editing transformation tables

Select an available transformation table using the combobox.

The sensor values and the converted values are displayed in the table on the left.
On the right, you see a corresponding diagram with the sensor values on the
horizontal axis and the converted values on the vertical axis. The table values are
linearly interpolated; in other words, the points are connected by straight lines to
calculate intermediate values.

During conversion, the first and last connection lines are extended beyond the
range of entered points (extrapolated) so that even sensor values outside of this
range are valid.

You can adapt each value in the table or add new value pairs in the last line,
which is marked with an asterisk (*). Newly added value pairs are automatically
sorted into the right place.

The following holds true for switches: Off = 0, On = 1.

Save the changes to the transformation table by clicking on the floppy disk icon.
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When you change a transformation table in one project, the changes do not
affect corresponding tables in other projects. However, you can return to the
original project folder from all projects through the entry <Other...> in the
combobox and open the changed table.

Setting up a new transformation table

When the dialog for editing a transformation table is open, you can create a new

table with the "New" icon. Select the physical quantities for the sensor values and
the converted values in the comboboxes above the table. You can also write any
other quantities into the text boxes of the comboboxes.

For the sensor values, only volts, ohms and on/off are meaningful input
guantities, because only these sensor types are supported.

Enter a description in the text box and add new value pairs in the last line of each
table, which is marked with an asterisk (*). A transformation table must have at
least two lines.

For switches, you can define an on/off inversion table with the assignments
0O>1land1->0.

Save the new transformation table by clicking on the floppy disk icon. The name
that you enter in the "Save file as" dialog will be subsequently offered as a
selection in the combobox.

If the name of the new table does not appear in the combobox on the
"Simulation" tab, open the project again.

The new transformation table is not directly available as a selection in the
combobox in other projects. However, you can return to the original project folder
from all projects through the entry <Other...> in the combobox and open the new
table.

Deleting a transformation table

When the dialog for editing a transformation table is open, you can use the
Delete icon to delete a table that has been selected in the combobox.

If the name of the deleted table still appears on the "Simulation” tab in the
combobox, open the project again.
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3.11 Displaying recorded trend data

=]

Variant

Variant

Click the symbol Trend display.

Click the project in the outline bar [C] with the right mouse button and select
"Trend Recall". Or select Project » Trend Recall in the main menu.

= Trend Recall g@@

E[ X l & '[ Standard_LM245-MP_test rig_00543-10256-142-143_20080722_081932_trend.bpttnd

Standard, LM24A-MP, test ng

%100
30 3
a0
70
60 e et
50
40

/
{
30 /
[
!
[ T

20
10
0 T

08:13:45 08:13:50 08:19:55 08:20:00 08:20:05 08:20:10
Time

Set Paint [%] = wnn Actual angle [%] Max Position [%] Min Position [%)

Device 00543-10256-142-143 Zoomf Left mouse button
Start time Dienstag, 2. Juli 2008 08:19:33 Move: Cilleft mouse button

2008-07-22 08:19:39 Set point Tool Reset: Double click
Close I

Trend recall

Select a trend file with the combobox.

Keep the CTRL key pressed and pull the diagram to the left or right with the
mouse in order to display values for other times.

You can use the copy button to insert the diagram into other documents via the
clipboard.

Use the save button to fix the window size of the trend display.

Printing a trend

Click the Print icon or press the key combination CTRL-P.

In addition to the Print button, you can open a menu with the "down" key. In

addition to printing, this allows you to display a preview or select several files for
printing with "Print multiple”.
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3.12 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

e
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Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options...

z PC-Tool Options

General
Feleaze Codes

Project base path:

MP channel configuration |'\‘\c:h1 fs1harafch$sBelimohPCT ool
Air module

Water Globe module B Do ey

Wik MWD 2k module

W Cormpact module Language:

Wil WRP-M module
Fire & Smoke module
EPFIY module

Log file:
" File per week {* File per month

[ Enable MP-tonitor

Simulation/Trend

¥ Enable sensor reading functionaliy

|Eng|ish ﬂ The new language setting becomes active
after a program restart.

[ Ask user if trendfiles should be saved [if not check save them alwaps).

Cancel

Dialog for basic settings (general)

N

"Project base path" sets the default directory in the file system, in which the new
project folder will be saved. You can override this information when creating new

projects, however.

When you mark the "Use default”, checkbox, new projects will be saved in your
user profile under "My Documents". With the operating system Microsoft

Windows XP (English), this folder is located under

C:\Documents and Settings\<Name>\My Documents.

You can open the folder "My Documents" with the "My Computer" icon.

The language that you select in the combobox will be used the next time that you

start the program.

Under "Log file", you can define whether a separate log file should be created

each month or each week.

Mark the "Activate MP-Monitor" checkbox to monitor the communication with the

actuators with the diagnostic tool.

In addition to "General", the names of the supported modules (actuator families)
are displayed on the left side. Further information on the module-specific settings

is found in the corresponding sections of this manual.
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3.13 Log file

Variants

All activities with the PC-Tool software that influence the data stored in the
actuator are recorded in a separate log file for every project. The time of each
action is logged.

Configuring the log file

You can create a separate log file for each week or month of a project (default:
File per month). To change this setting, select Tools»PC-Tool options in the main
menu. You can select either ‘File per week' or ‘File per month' under ‘General'.

Reading the log file

Click the "Read log file" icon in the toolbar.

Click the project icon in the outline bar [C] with the right mouse button and select
Read log file. Or select Project PRead log file in the main menu.

Using the combo box ‘Log file', you determine the file to read. The contents of the
log file are displayed in a table in the top section (each action starts a new row).

By clicking a column title, you can sort the table according to the selected
column. By clicking again on the same column title, the sorting direction is
reversed: increasing (A-Z) or decreasing (Z-A).

Details
Click a table row to display details of this action in the bottom section.

You can print the text in the detail area ("Print..." button) or copy it to the
clipboard ("Copy" button) and then paste it into another document.
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Read logfile

Logfile |M-2006-02 bptlag -

Logevents:

Date Time Ewvent Pozition string Type Sernes no. PAP-Ag -
0202 2006 09.42:31 Read all parameter  F-10001 LF24-+FT2 00404-100597-080-03 PP
0202 2006 09.42: 31 Wwirite all parameter  P-10001 LF24-+FT2 00404-100597-080-03 PP
0202 200611.27:08  Read all parameter  P-10001 LF24-FT2 00404-100597-080-03 PP
02022006 11.31:20  Read all parameter MNbdw-Di2-bdP 00B03-30024-146-13  MP4
0202200614 4216 Read all parameter MNiW-D2-MP 00B03-30024-146-13  MP4 2
02022006 14.43:09 Read all parameter by pozition Sk2448-MP 00534-00026-14212 PP
02022006 16.05:21 Read all parameter My pozition Sh248-MP 00534-00026-14212 PP
02022006 16.05:31 Read all parameter  kMy pozition Sh244-b P 00534-00026-14212 PP
02022006 16.09:04  Read all parameter My position Skl 240w P Q0534-00026-14212 PP
0202 2006 16.05:10 Fead all parameter by pozition Sk 2448-MP 00534-00026-14212 PP
M2 072 2NNR 1R 3R-10 Fead all narameber AF2Al MM nna13-1nm 9-n=a-nq MF'LIj
4 3
K.ey W alue ~
Date/Time 02022006 14,4216

Event Fead all parameter

Position string

Type Wi -D2-MP

Sefies no. 00B03-30024-146-139

MP-Adresze MPa

Project name testprop_tmp

SM 00B03-30024-146-139

Type M -D2-bP

Dezignation

Fozition

Address MP4

Contral type A

Calibration walue 2628

Yaolumetric flow setting W'nom: 3303 m3/h, Wmid: 1652 m3dh

Wrnir: O rm3dh, W maw 3303 m3dh

Cay feature Standard

Control function ' DC 210

Semaitivito rinrrnAl b’
< >

Copy Frint... Cloze
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4 Attachment

4.1 Storage locations of files

4.1.1 Project data

The default project is stored as a "Default project” sub-directory in the installation
directory of the program.

The projects are user-specific and are stored as a sub-directory in the user
profile. For an English-language version of Windows, this is

C:\Documents and Settings\<Name>\My Documents\Belimo\PCTool

This directory contains sub-directories with the project names.

4.1.2 Configuration files

The user-specific settings are stored in the user profile under "Application data".
For an English-language version of Windows, this is

C:\Documents and Settings\<Name>\Application Data\Belimo\PCTool

This directory can be "hidden" under Windows. If it is not present, the settings will
be queried upon starting.
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4.2 Configuration files for printing labels

4.2.1 Storage location

The filenames have the extension * .bpt1lb. They are saved in the "label

definition’

" directory for each project. For an English-language version of

Windows, this is

C:\Documents and Settings\<Name>\My Documents\Belimo\PCTool\ <Project>\label definition

4.2.2 Format

The configuration files for label printing are stored in XML format. You can edit
these files with an editor program, for example "Notepad".

Configuration files for common Avery and Zweckform labels are supplied with the

program.

Example of a configuration file

<Lines>
<Line
<Line
<Line

<Line

<?xml version="1.0" encoding="utf-8"?>

<LabelDefinition xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi=

"http://www.w3.0rg/2001/XMLSchema-instance">

<PageSize Height="278" Width="214" />
<PageBorder Top="18" Left="5" />
<LabelSize Height="33" Width="100" />
<LabelBorder Top="5" Left="5" />

<Labellogo Path="Logo.bmp" Top="0.5" Left="2" Height="15.8" Width="41"/>

Text="" />
Text="{0} / {1}" />
Text="{20}" /> <Line Text="{21}" />

Text="{23}" />

<Line Text="{41} / {42}" />
</Lines>
</LabelDefinition>
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4.2.3 Boxes
You can adapt the values for the page layout (values in millimeters) for new label
formats.
PageSize Page size (height and width)

PageBorder Border width (top and left) = distance from the top left corner of
the first label to the page border

LabelSize Size of an individual label

LabelBorder Label border width (top and left) = distance of the lettering from
the label border

LabelLogo It is possible to print a Logo (picture) on the label.

Path: Here the path relative or absolute is entered for the Logo
File: (Logo.bmp) or (C:\pictures\Logo.bmp)

Position (upper and left) = Positon of the bitmap relative to the
upper left corner of the label (border not included)

The bitmap will be printed over the <Lines>. Therefore optionally
some blank lines must be inserted.

In every line element <Line>, you can insert place holders where certain project
and actuator characteristics will be added during printing.
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{0} Company name (from project data)
{1} Project name

{10} Actuator type

{11} OEM designation

{12} Position

{13} Serial number

{14} MP address

{20} Control type Y

{21} Feedback signal U5

{22} Range of rotation min — mid — max
{23} Running time

{24} Direction of rotation (cw /ccw)
{25} Bus fail position

{26} Sensitivity

{27} Synchronization at

{28} Torque

{29} Nominal range

{30} Conductance

{31} Vhom

{32} Vmax

{34} Vmin

{36} Control fct.

{37} Mode

{40} Printing date

{41} Text with consecutive numbering
{42} Freely definable text 1

{43} Freely definable text 2

{44} Freely definable text 3

{50} Switching point S1 in degrees (°)
{51} Switching point S2 in degrees (°)
{52} Setting damper free running test
{53} Valve Size (EPIV-Modul)

{54} Power Fail Delay (Super Cap)
{55} Power Fail Position / Power off Position (Super Cap)
{56} Ap@Vnom (VAV-Compact D3)

You can define up to 50 lines. The program does not check whether the lines fit

on a label.

When you define a new configuration file in a project, this configuration will not be
directly available in other projects. However, you can return to the original project
folder from all projects by using the entry <Other...> in the combobox, and then

use the file.

39 /51



T
PC-Tool V3.6 General part, user manual BEL'MO

4.2.4 Example of a label

The following example results in a label having the dimensions width x height =
50 mm x 20 mm. The example is intended for an endless label printer that prints
labels of the size 50 mm x 20 mm.

The company name, the project name, the actuator type, the type of control
signal and the running time are printed on the label.

This data yields the following configuration file and the subsequently displayed
label:

<?xml version="1.0" encoding="utf-8"?>
<LabelDefinition
xmlns:xsd="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<PageSize Height="20" Width="50" />
<PageBorder Top="0" Left="0" />
<LabelSize Height="20" Width="50" />
<LabelBorder Top="5" Left="5" />
<Lines>
<Line Text="{0}" />
<Line Text="{1}" />
<Line Text="Type: {10}"/>
<Line Text="{20} Running time: {23}"/>
</Lines>
</LabelDefinition>

Label: (0}

Belimo A‘M{ 1)
Sample

Type: LM24A-MP 4 {10}
Y: Open/Close Running time: 40s

\ T

{20} {23}
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4.3 Troubleshooting and error messages

4.3.1 General

Problem After the program starts, an MP-Channel is not opened but displayed with the

MP-Channel icon.

Solution The MP-Channel cannot be opened, for example because the selected serial
interface is assigned to another application. Check whether a modem or a
communication program is using this interface.

4.3.2 Error messages

Error message

Description

Start adaptation failed.

Communication failure on the MP-Channel or faulty actuator.

Actuator locked for PC-Tool.

The drive has been configured so that it can be neither read
out nor programmed with the PC-Tool.

Summary: Actuator not reachable

Communication failure on the MP-Channel or faulty actuator.

Summary: Actuator run into timeout.

The drive did not respond within the specified time.

Answer has too much data.

Conflict between the actuator and program. The program
library (belipp.dil) may not be up-to-date.

Answer doesn't have enough data.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Command has not enough parameters.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Command parameters out of range.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Belimo library error code = ....

Internal fault.

Description is missing

A transformation table must have a description.

Bus Jam

Two or more devices respond to the same address. Re-
address the actuators.

This field is required!

This field must have an entry. It is not allowed to remain empty.

There is already an instance running!

The program cannot be started on a computer where it is
already running.

Error while creating the project!

Check whether it is possible to write to the storage location of
the project.

Error while copying default project.

When a new project is created, configuration files and sub-
directories are normally copied from the default project in the
installation directory of PC-Tool. The default project has
probably been accidentally deleted, moved or renamed.

Default project directory '..." does not
exist! Please reinstall the application.

When a new project is created, configuration files and sub-
directories are normally copied from the default project in the
installation directory of PC-Tool. The default project has
probably been accidentally deleted, moved or renamed.
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Error message

Description

Command ... unknown by the device

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

The value must be between ... and ....

The entry is not in the permitted range of values.

Invalid data answer from the device.

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

The difference is smaller than ....

A rule for the minimum difference between two values has
been violated.

The length of the string must not
exceed ... characters.

Shorten your entry.

MP-command ... unknown by
PP_Function

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

A transformation table must have at
least 2 points.

A transformation table must have at least 2 lines to be able to
calculate intermediate values.

Not all parameters written to device

(Note the detailed instructions with the message regarding the
reason for the error.)

Label print failed.

(Note the detailed instructions with the message regarding the
reason for the error.)

Wrong device family ... instead of ...

When setting the parameters of small batches, an actuator
from another actuator family was connected and does not
match the parameter file.

Wrong transformation table for this
sensor type. It cannot transform from
unit ...

The transformation table does not have the measuring quantity
of the sensor in the first column. Resistance sensors must
convert 'ohm' into the target parameter, for example.

Wrong device connected!

This fault occurs when actuators are changed during
parameterization. Read the parameters out again.

Wrong MP channel: "...".

The MP-Channel has changed.

Error starting testscript

The test script is invalid.

Label printing error

(Note the detailed instructions with the message regarding the
reason for the error.)

Error loading transformation table

(Note the detailed instructions with the message regarding the
reason for the error.)

Error while loading project file: ...

(Note the detailed instructions with the message regarding the
reason for the error.)

Error reading parameter file

(Note the detailed instructions with the message regarding the
reason for the error.)

Error opening Channel ....

(Note the detailed instructions with the message regarding the
reason for the error.)

Error opening file explorer

File Explorer could not be started when displaying MP-Monitor
files.

Error opening MP-Monitor

(Note the detailed instructions with the message regarding the
reason for the error.)
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Error message

Description

Error while saving test report!

(Note the detailed instructions with the message regarding the
reason for the error.)

Error while processing line ... of the
trend file ...

The trend file could not be interpreted. It was probably written
manually.

Error: Invalid code for the module
release.

Relates to the entry of the activation code. Please check your
entry. All boxes must be filled-out according to the
requirements.

Error: There is another device on MP1

Address conflict.

Error: Unable to change address to
MP1

Address conflict.

Error: no answer from actuator

Communication failure on the MP-Channel or faulty actuator.

Address ... already set to this device!

Re-addressing re-assigns an already existing address.

Module release code expired!

Please contact your representative for a replacement of the
code.

Character '..." is not allowed (not ISO-
8859-1)!

Only characters from the Western European character set are
permitted for Description and Position of an actuator (see table
in Section 4.3.3).

No answer (possible bus jam).

Communication problem on the MP-Channel or faulty actuator.

No answer from device.

Communication failure on the MP-Channel or faulty actuator.

No label configuration file chosen.

Please choose a valid label configuration file and print a test
label or uncheck print label after write.

No or empty setup string.

"Other" was selected when setting the communication
parameters, but no connection was specified.

Could not deaddress other device

Address problem. (Note the detailed instructions with the
message regarding the reason for the error.)

Couldn't write to the device!

Communication failure on the MP-Channel or faulty actuator.

Could not find the VRP-M Tool
executable. Would you search for it
now?

Concerns VRP-M controller. The corresponding program could
not be found at the location specified in the PC-Tool options.

Configure the path in the options (menu Tools/PC-Tool options
in VRP-M).

Could not find PC-Tool V2.1. Would
you search for it now?

Affects VAV actuators. The old version of the program could
not be found at the location specified in the PC-Tool options.

Error while loading project.

(Note the detailed instructions with the message regarding the
reason for the error.)

MP-Command ... failed.

Conflict between actuator and program. The program library
(belipp.dll) may not be up-to-date. MP command could be
password-protected.

MP-Channel was closed

The MP-Channel was closed during an asynchronously
running function.

Not all data written to the device.

Communication problem during writing of the parameter data,
possibly due to bus jam. Check the connection and addressing
of the actuators. An MP command is password-protected or
the actuator is not familiar with the command.
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Error message

Description

Could not read all data from the device.

Communication problem while the parameter data was read,
possibly due to bus jam. Check the connection and addressing
of the actuators.

Not all fields have valid values! Can't
write data

One or more input values in the "Configuration” tab is not valid.
Look for a flashing exclamation mark. If you move the mouse
pointer to the exclamation mark, an explanatory text (tooltip)
with the valid range of values will usually appear.

OEM or BELIMO password necessary.
Please contact OEM-Manufacturer

Parameters on the actuator can be protected with a password
against changes. A password is necessary to overwrite them.

Parameter file contains no series
number

When setting the parameters of small batches, the actuator
family is checked by means of the serial number. The
parameter file is old or has been changed manually.

Error opening configuration file

(Note the detailed instructions with the message regarding the
reason for the error.)

Error storing configuration file

(Note the detailed instructions with the message regarding the
reason for the error.)

Plausibility check: Failed. Please check
the configuration dialog for further
information.

Testing is not started if there are errors in the configuration.

Problems opening the MP-Channel "...".

Error at the interface. Check the communication parameters
and the cabling.

Sending ... to ... returned error ...

Conflict between actuator and program. The program library
(belipp.dil) may not be up-to-date.

Wrong format of serial number

You have made a typing error while manually entering the
serial number. Check the notation of the serial number.

Series number has a wrong format!

You have made a typing error while manually entering the
serial number. Check the notation of the serial number.

Reset alarm messages failed

Communication failure on the MP-Channel or faulty actuator.

Synchronization failed

Communication failure on the MP-Channel or faulty actuator.

The test script cannot be started because
some conditions are not complied.

A certain minimum air flow or system pressure is necessary for
the test. Please check fan and VAV box.

Start test run failed

Communication failure on the MP-Channel or faulty actuator.

New address could not be verified

The serial number is read before and after an actuator is re-
addressed. These two numbers do not match. Another
actuator probably answers to the programmed address.

Unknown MP-Channel '...".

The MP-Channel could not be identified.

Invalid or corrupted parameter file '..."

The contents of the file could not be correctly interpreted. The
format may no longer be valid. If possible, read out the
parameters again and save them in a new file.

Invalid Series Number

The entered serial number was not found in any connected
actuator.

Invalid value entered

Refer to the notes about the valid range of values.

Invalid value!

Refer to the notes about the valid range of values.
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Error message

Description

Unspecific Belimo-Lib error

Internal fault.

Must be greater than zero.

Refer to the notes about the valid range of values.

Must be an integer.

Refer to the notes about the valid range of values.

Summary: Test cannot be executed
due to active forced control

Remove the Y connection with the control signal for the
duration of the test.

Two or more devices respond to the
same address.

Bus jam Re-address the actuators.
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Only characters from the ISO 8859-1/ANSI character set are permitted in the "Description" and "Position"

box

Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char | Pos | Char
32 64 | @ 9% |° 128 | € 160 | 7 192 | A 224 | a
33 |! 65 |A 97 |a 129 |- 161 | 193 | A 225 | &
34 | 66 | B 98 | b 130 |,V 162 | ¢ 194 | A 226 | a
35 | # 67 | C 99 |c 131 | f 163 | £ 195 | A 227 | &
36 |$ 68 | D 100 | d 132 | ,? 164 | o 196 | A 228 | 4
37 | % 69 | E 101 | e 133 | ... 165 | ¥ 197 | A 229 | &
38 | & 70 | F 102 | f 134 | t 166 | ! 198 | £ 230 | &
39 | 71 |G 103 | g 135 | £ 167 | § 199 | C 231 (¢
40 | ( 72 |H 104 | h 136 |~ 168 |- 200 | E 232 | &
41 |) 73 |1 105 |i 137 | %o 169 | © 201 | E 233 | é
42 | * 74 | J 106 | | 138 | S 170 | @ 202 | E 234 | &
43 | + 75 | K 107 | k 139 |« 171 | « 203 | E 235 | é
44 |, 76 | L 108 || 140 | CE 172 | - 204 |1 236 | i
45 | - 77 |M 109 | m 141 | » 173 | -9 205 || 237 | i
46 | . 78 | N 110 | n 142 | Z 174 | ® 206 |1 238 |1
47 |/ 79 | O 111 | o 143 | » 175 |~ 207 |1 239 | i
48 |0 80 |P 112 | p 144 | » 176 | ° 208 | B 240 | &
49 |1 81 |Q 113 | q 145 | ¥ 177 | + 209 | N 241 | fi
50 |2 82 |R 114 |r 146 | ' 178 | 2 210 | O 242 | 0
51 |3 83 |S 115 | s 147 | " 1179 |3 211 | O 243 | 6
52 | 4 84 | T 116 |t 148 | "9 180 |~ 212 | O 244 | 6
53 |5 85 | U 117 |u 149 |« 181 | 213 | O 245 | &
54 |6 86 |V 118 | v 150 | — 182 | 1 214 | O 246 | 6
55 |7 87 | W 119 |w 151 | — 183 215 | x 247 | +
56 |8 88 | X 120 | x 152 |~ 184 | | 216 | @ 248 | @
57 |9 89 |Y 121 |y 153 | ™ 185 |t 217 | U 249 | U
58 |: 90 |Z 122 |z 154 | & 186 | ° 218 | U 250 | U
59 |; 91 |[ 123 | { 155 |» 187 | » 219 (U 251 | O
60 |< 92 |\ 124 || 156 | e 188 | Y4 220 | U 252 | i
61 |= 93 |] 125 |} 157 | » 189 | % 221 | Y 253 |y
62 |> 94 |~ 126 | ~ 158 |z 190 | ¥ 222 | b 254 | b
63 |? 95 | _ 127 159 | Y 191 | ¢ 223 | R 255 |y
Ehe character positions marked with « are vacant.

2)
3)
4)
5)
6)
7
8)

Single speech mark, low
Double speech marks, low
Single left speech mark
Single right speech mark
Double left speech marks
Double right speech marks
Non-breaking space
Breaking hyphen
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4.4 Typical wiring diagrams

4.4.1 Overview table
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No)

Cable MP level converters and devices Drawing Page
ZK1-GEN
; = ‘/\/ ZIP-USB-MP | Typical wiring diagram 1 | 48
ZK2-GEN
_ — Typical wiring diagram 2 48
=~ ZIP-USB-MP
Ax ' Typical wiring diagram 3 | 49
ZK6-GEN
w — ZIP-USB-MP Typical wiring diagram 4 | *°
ZKS-MP
i 4 ‘:\j‘.,(’ Y _ _ . . .
;‘\;, ;'..%} . ZIP-USB-MP | Typical wiring diagram 5 | 50
ZK1-VAV
— Typical wiring diagram 6 50
D S /\/ ZIP-USB-MP
{ﬁ , 7 Typical wiring diagram 7 51
Direct connection . J ZIP-RS232 | Typical wiring diagram 8 | 51

For further wiring examples with miscellaneous connection cables und level converters see
www.belimo.eu | Documentation | Bus- and System-Integration | "Tool connection guide"
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4.4.2 Typical wiring diagrams

Typical wiring diagram 1

4
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BELIS RJ11 (6/4)
Belimo é g
PC-Tool - g oo g
O Initialized E
: — gy ———4
! \ ZIP-USB-MP 43 ZK1-GEN GND
...A-MF \ '
...A-MP @ oo F
...D2-MP c r
...ALON ﬁ 2
...D2LON 7 1
Typical wiring diagram 2
~ AC24V
- + DC24V
RJ11 (6/4)
/4
. < BELIMO ZK2-GEN
Belimo . @
PC-Tool g oo 3 MP
E QO Initialized g
\ a s GND
/ \ ZIP-USB-MP Ce
| — usB
white/weiss = GND

blue/blau = not connected/nicht angeschlossen

green/griin = MP 1 {f
= >
..MFT(2) ..LON 1L~ usmp
~AMF  alon T T
+A-MP D21 ON
...D2-MP
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Typical wiring diagram 3
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MP-Master

DDC Controller

RJ11 (6/4) UK...Gateway
V4
- BELIMO
Belimo n g ZK2-GEN
=) O Enable
PC-Tool | = Foom § GND 24V MP
2 =
/ \ ZIP-USB-MP € oD
[ ! usB white/weiss = GND ““@--“@-“f-“
blue/blau = not connected/nicht angeschlossen
green/griin = MP MP
L
....A-MP
...D2-MP
..MFT(2)
Typical wiring diagram 4
. BELINTS RJ11 (6/4
oo g
Initialized 'Q
. & ZK6-GEN
ZIP-USB-MP €3

usSB

RJ11 (6/4

[OlO]O]H[C[C[O]

BELIMO

Optimizer
COU24-A-MP

[CIC[O[C[O[O[O[0]

lolojolo]o]ojolojo] [o]oojololololo]o] [o]o]o]olo]o]
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Typical wiring diagram 5

UK24LON/EIB BELIMO

o oo |g oo

MP-Monitoring — ’\[%:JQH (O] ©@ ® ®

Pos. ,MO*
LonTalk MP-Com. Power
a b OV 24V Y UIMP OV 24V n.c.

g @ecg @eag

UsB
: = i BELIMO L]
Belimo n 0
PC-Tool g /O 3
[o] O Initistized &\4 /mﬂ }
[\ ZpussMP e
— UsB AC24V 1 ~
DC24V — +
ZKS-MP |
............. —_— 9
..A-MP
...D2-MP
..MFT(2)
Typical wiring diagram 6
. BELINTS RJ11 (6/4
Belimo m 5
PC-Tool g o o
E QO Initialized &\'
) g =
- N
/ \ ZIP-USB-MP q3 NMV-D2M BELIMO
| I USB
ZK1-VAV
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Typical wiring diagram 7
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. BELIATS RJ11 (6/4
Belimo " %
PC-Tool g oot 5
Q Initialized g g
) = CR24.. o
-\ ZIP-USB-MP <€ " :
' — USB : o
o) O
le) (@]
O
ZK1-VAV /'
Typical wiring diagram 8
ZN230-24 ] O
= AC 230/ 24 V Belimo | /&7
AC 230V PC-Tool 14
(o]
A
| —
ZIP-RS232 BELIMO
Actg;\tor I i Upp §
@ @ @ %)) D-Sub
a g
OFF
T 1°°2 5
1 2 3 5
C i)
L~ uy .. MFT(2)
- + MP ... A-MF
..... A-MP
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1 Introduction

The "Air module" user manual describes the detail area [D] of the Air module.
The documentation is divided according to the three index tabs "Service",
"Configuration” and "Simulation”.
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2 Service

2.1 Displaying settings

4
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The Service tab gives an overview of the current settings of the actuator.

Service | Configuration | . Simulation

Actual settings

Control function 'y
Sensitivily
Feedback US

Mominal range
Running time
Angle of rotation

Direction of rotabon
Synchronization at

Torque

Power Fail-/Power off Pos.
Power FailDelay
Power Fail Count

Bus fail position
Power ON
M anual button [once]

Actuator information

Firmware
Config tahle 1D
Data log
Operating time
Active time
Stop & Go ratio
Messages

Messages

DC 210
varniable
Damper poszition, 2-10°%

birn: 05
95" adapted
90z
Max: 100%  [95°]
Min: 0% [0°]

& |y=
1003

Mid.: 50%  [487]

o
Y=0%
100%
0%
2z

93

Laszt walue
Mo action
Mo action

Y01.24 -6
0x1 088

12h

0%

& 100%

W

Test

Adaption

Synchronization

Rezet Meszages

Service tab for full-rotation damper actuators

For linear actuators the stroke is displayed instead of the angle of rotation, and
the torque instead of the positioning force.

Mominal range
Running ime

Direction of siroke
Synchronizaton at

100 mm
150s

Maoc: 100%
Min: 0%

Stroke [100mmi]

[Omm]
= u

up 100% TP

Y% ‘J

Force 100%

adapted

Mid.: B0%  [50mm]

Service tab for linear actuators (excerpt)
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Meaning of the settings
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Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

Feedback U5

Type of feedback signal

Range

Position range within the mechanical limits

Running time

related to operating range or a fixed angle/stroke of
95°/100mm (with annotation)

Angle of rotation

Programmed rotation range: Min / Mid / Max
(for full-rotation actuators)

Stroke

Programmed stroke range: Min / Mid / Max
(for linear actuators)

Direction of rotation

Clockwise/counterclockwise (for full-rotation
actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque (for full-rotation
actuators)

Actuating force

In percent of maximum positioning force (for linear
actuators)

Power fail-/Power off Pos.

Actuator position in case of power fail (exists only on
actuators with Electronic Fail Safe modules)

Power Fail Delay

time delay until actuator drives to power fail position.
(exists only on actuators with Electronic Fail Safe
modules)

Power Fail Count

Number of power Fail counts (exists only on
actuators with Electronic Fail Safe modules)

Manual button [once]

Function when pressed once

Manual button [twice]

Function when pressed twice
(not present in "New Generation™" actuators)

Function table

Assignment of override setting and override function

(only for certain actuators)

Firmware

Software version on the actuator

Config table ID

Identification of the configuration table

Operating time

Number of hours during which the actuator was
connected to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power

supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high
Stop & Go ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain

actuators.
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2.2 Adaptation

Variant

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

Click the "Adaptation" button on the Service tab.

You can also trigger the adaptation directly on the actuator. The necessary
buttons for this can be programmed. For example, "Manual button [twice]" can be
assigned the adaptation function.

The progress of the adaptation is displayed in the status line. The actuator first

moves against the programmed direction to the zero stop and then to the end
stop at the full angle of rotation.

Next, the absolute values for a programmed limited angle of rotation range
(minimum, mid-position, and maximum) as well as the feedback signal U5 are
recalculated and displayed.

The adaptation can be blocked in certain actuators.

2.3 Synchronization

Variant

In the case of synchronization, a mechanical limit is moved to in order to
determine the absolute range.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or at the full angle of rotation/stroke (100%).

Click the "Synchronization" button on the Service tab.

You can also trigger the synchronization directly on the actuator. The necessary
buttons for this can be programmed. For example, "Manual button [once]" can be
assigned the synchronization function.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop at the full angle of rotation/stroke.

The synchronization can be blocked in certain actuators.
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2.4 Function test

The function test checks for opening and closing.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the angle of rotation (or stroke) is set to "adapted",
movement takes place to the other stop; with "programmed", on the other hand,
to the programmed range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

— Test progress: r— Current position: —
Gl P Start Test
- Plausabiility test 4% 47
- Messages deleted
- Actuatar runs OFEN Ted state: Abort Test
- Actuator runs CLOSE Esl et
Testunning
[laze Tiest

r—Test report:

| 8

Display of test progress and test report

Click the "Start Test" button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the actuator,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current actuator settings.

If the test reports an invalid actuator configuration, go to the "Configuration” tab
after ending the test. The values that are not allowed are marked with a flashing
exclamation point.
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You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the "Close Test" button. The program asks whether you
want to save an unsaved test report now.

Save testreport? |
@ Wiould you like to save the kestreport?
Yes Mo |

If you cancel the test early, the actuator will be reset to its original state. No test
report will be created.
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3 Configuration

On the "Configuration” tab, you can read out parameter values from the actuator,
change them and save them back to the actuator. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

Service Configuration | *, Simulation |w

Designation |NM24-MFT2

Position |
Start Stop
Control signal Y |0C 210V =
Read
Min Mid Max Write
Angle of roation 0 % (0.11%) 55 % (0..100%%) 100 % (89..100%%)
o~ 19 * 34 - Store to file__
Running ti 7.107: :
Hnning fime 50 ERE Load from file_
Reduce F Y
Angle of rotaion |ac|a|:|tec| j | 3 -
L NS 'y
Direction of rotation @on% (—- cew
oW

Bus fail position [Last valie =

Sensitivity m

Synchronization at m
Torque |75 -| %

Power ON [Synchronization v |

Manual button foncel: m

Manual button fiwice]: m

"Configuration" tab for full-rotation damper actuators

Note: Running time, range, direction of rotation and stroke cannot be
programmed on certain actuators and are therefore not displayed.
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For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

Min Mid [z

Stroke % (0.90%) | B0 3% (0..100%) 100 % (10..100%)
0 mm | 5 mm 1000 mim

Running time 150 s (B7.275s)

Reduce &

Stroke |adapte-:| j | 100 mm

T= 3
Direction of stroke 1003 1t ol

" down

"Configuration" tab for linear actuators (excerpt)

Synchronization at |'v=0% |
Torque |1EIEI j x
Power ON |N|:| action j
Power Fail-/Power off Pos. |_|:| = Power Fail Delay l_g 5

M anual button [oncel | Mo action ﬂ

"Configuration" tab for Electronic Fail Safe (excerpt)

Actuator number*

Description 16 characters of any text

Position 16 characters of any text

Control signal Y

3-point AC voltage, positions: Open / neutral / closed
Open / closed DC or AC voltage, 2-point
DC 0-10V (DC voltage)
Fixed operating range DC 0-10 V
DC 2-10V (DC voltage)
modulating Fixed operating range DC 2-10 V
DC variable Start (Y=0%) 0.5 ... 30 V
Stop (Y=100%) 2.5 ... 32V
Range between start and stop at least 2 V

! Only characters from the Western European character set are permitted for Description
and Position (see General part, table in Section 4.3.3).
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PWM 0.02-5 s

Duration of the control pulse (pulse width modulation),
fixed operating range

PWM 0.1-25.5s

Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s

Duration of the control pulse, fixed operating range

PWM variable

Start (Y=0%) minimum 0.02 seconds
Stop (Y=100%) maximum 50 seconds

VAV 4 +/- 6V

When this function is selected, the actuator is
parameterized as a VAV actuator and can therefore be
controlled by the VAV controllers VR.. .

Note:

When VAV (6 + 4 V) is selected, the values for minimum,
maximum, intermediate value, running time and angle of
rotation/stroke are reset to the default values.

4-20 mA

(Direct current)
Fixed operating range DC 4-20 mA

Note:
This selection is only available for certain drives (e.g.
"SunYeh")

mA variable

(Direct current)
The values for start and stop are specified in the actuator
and cannot be changed with the PC-Tool.

Note:
This selection is only available for certain drives (e.g.
"SunYeh")

Feedback U5 (only active when the actuator address is set to PP)

Damper position,
2-10V

DC voltage measurement signal, fixed range

Damper position,
0.5-10V

DC voltage measurement signal, fixed range

Damper position,
variable

DC voltage measurement signal
Start 0.5...8.0 V/ Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Damper position,
4-20 mA

Direct current measurement signal, fixed range

Certain actuators can define further feedbacks, which
you cannot change, however.

U5 scaling (only with "New Generation" actuator, MF or MP types)

Start

Position in percent, corresponds to the start value of the
feedback signal

Stop

Position in percent which corresponds to the stop value
of the feedback signal

Angle of rotation (for full-rotation actuators)
Stroke (for linear actuators)

Min

Programmed lower limit of the range
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Mid Mid-position of range

Max Programmed lower limit of the range

An existing value for Mid is automatically adapted when Min and Max are
entered: If you enter Min, Mid is always larger than or equal to this input value. If
you enter Max on the other hand, Mid is always less than or equal to this value.

Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V min: 30%, max : 70%
Feedback U5 : 2...7 V start: 20%, stop: 90%

Position

Open 100% —3-

50% —=-=+d4=-=-T7=-=-F-=-r-
_________________ -
1
Ny E— | R
1 1 1 1
1 1 1 1
e e e e e R e
Closed 0% N T T O O R £
T 1T 1T 1T 1T 1T - [V]
0 5 10
Running time
In seconds Time needed to pass through the range limited by Min and

Max (the valid range of values for the running time
depends on the actuator type and the passed-through
range).

Note: For actuators with the "constant speed” operating mode, the speed does
not depend on the range passed through. The running time refers to a fixed angle
of 95° for rotary actuators or a fixed stroke of 100 mm for linear actuators.
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Angle of rotation (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal
setting range of the actuator

Direction of rotation (for full-rotation actuators)

cw

Damper opening in the clockwise direction

ccw

Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)
down Downward-opening damper

Power Fail-/Power off Position (only with Electronic Fail Safe module)

in %

emergency Position at Power Fail (can only be changed
when poti is in "Tool" position)

Power Fail Delay (only with Electronic Fail Safe module)

in seconds

time delay until actuator drives to emergency position in
power fail case.

Behavior in the event of bus failure

Last setpoint Position according to control signal Y

Open Move to full angle of rotation/stroke (100 %)
Close Move to zero stop

Close quickly Close with maximum speed
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Sensitivity
Sensitivity Actuators without | Actuators with | Actuators of the
spring-return: spring return: new generation
NM24-MFT(2) | LF24-MFT(2) |3ndlinear:
AM24-MFT(2) AF24-MFT(2) .MF
GM24-MFT(2) ..MP
..LON
Normal
— Response sensitivity: 1° angle of 1° angle of 1%
rotation rotation @ operating range
(SY 2 2%)
— Reversal hysteresis 2.5° angle of 2.5° angle of 2.5%
rotation rotation @ operating range
(SY > 3%)
Damped
— Response sensitivity: 2° angle of 2° angle of 2%
rotation rotation @ operating range
(SY > 5%)
— Reversal hysteresis 5° angle of 5° angle of 5%
rotation rotation @ operating range
(SY > 6%)
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Synchronization at

Y = 0% Moves to the mechanical limit at zero stop (depending on
the direction of rotation / stroke direction)

Y = 100% Moves to the mechanical limit at full angle of rotation
(depending on direction of rotation / stroke direction)

Note: When the nominal setting range is set to "programmed", then the
synchronization MUST be carried out at Y=0%.

Torque (for full-rotation actuators) / Positioning force (for linear actuators)

25% ... 100% Can be set in increments of 25%. 100% corresponds to the
maximum torque / the maximum positioning force for the
actuator type (see nameplate)

Power ON
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Nothing (This option is not available for actuators of the "TOP"

performance class. When switched on, they must always be
adapted or synchronized)

You can programmatically limit the rotation and stroke range at one end by only
changing the minimum or the maximum. If the value of Power ON is set to
"Nothing", then the following holds true:

The mechanical limit that can still be attained within a rotation range
limited at one end will be used for synchronization.

If you set the minimum to a value greater than 0%, the zero stop will no longer be
in the range. In this case, synchronization will take place at the end stop of the
full damper opening (Y = 100%). If, on the other hand, you set the maximum to a
value smaller than 100%, synchronization will take place at the zero stop (Y =
0%).

This is also valid for the case that the nominal setting range is set to
"programmed" and the minimum is equal to 0%: The setting "Power ON: Nothing"
is allowed.

Synchronization when the angle of rotation/stroke is limited at both ends

If the minimum is greater than 0% AND the maximum is smaller than 100%, then
you can select where the synchronization will take place. In this case, it is
necessary to perform synchronization or adaptation when you switch the device
on (the setting "Power ON: Nothing" is considered an error).

If the nominal setting range is set to "programmed" and the minimum is greater
than 0%, then the same rule applies: At least one synchronization must be
programmed.
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Manual button [once]/[twice]

Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at") when the manual button is pressed
once or twice respectively

Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters when the manual button is pressed
once or twice respectively

Note: For "New Generation" actuators (types MF, MP), the function
Manual button [twice] is not available.

Function table for behavior when Y-control signal is missing

Condition Y Reaction
No Y-signal: No fct Cable disc. None
Earthing (GND) | CLOSED
No Y-signal: OPEN Cable disc. OPEN
Earthing (GND) OPEN
No Y-signal: CLOSED | Cable disc. CLOSED
Earthing (GND) | CLOSED
No Y-signal: STOP Cable disc. STOP
Earthing (GND) STOP

Activate the "Show function table" checkbox in order to show the function table.

For addressed MP actuators selecting a reaction is not possible.
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4 Controller simulation

Go to the "Simulation" tab.

Servicel Configuration B Simulation | | W

Actuator

Set point Actual position
| 900 | 227z | 222-%

" Simulation off

{" SetpointY
¥ Setpoint Tool 5.20 v 389 v
" Motor stop Trendview (% %

Interval 243 | Trend [ ] | Comment... | I0449—20025—052—059_20050321_1 44848 wend.bptind

—Trend

ACHME, NM24-MFT2. Rooml

% 100
90
80
70
60
50
40
30
20
103

o]

T T =| T =| T T T T T T T T T T T
14:48:504:48:514:48:53 4:48:53 4-48:54 4- 4859 4- 4550 4- 4857 4- 4858 4-48:594-49:004: 49: 01 4: 49:02 4- 49:03
Time

SetPoint [X%] Actual angle [%] Max Position [¥] Min Position [%]

Simulation tab for damper actuators

The controller simulation is not possible while the actuator is performing an
adaptation or synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y
according to selected control type (DC, PWM, open/close, 3-point).

Setpoint Tool (not available with control type open/close or 3-point): The setpoint
is entered in % of the programmed range. 0% is the minimum, 100% the
maximum. The input values are converted and displayed in the units of the
corresponding control signal (volts, milliamps or seconds).

The control is switched off when you click "Motor stop”. This function is not
available with the control types open/close and 3-paint.
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Measurement values

During the simulation, the current angle of rotation or stroke is displayed in % of
the absolute (mechanically limited) range and — converted according to the scale
setting — as a feedback value in volts or milliamps.

4.2 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function,
however, must be activated in advance in the PC-Tool options under "General".
Select Tools » Options in the main menu.

H ol Options

roject base path

Release Codes
MP channel corfiguration |C:"'-.D0kumente und Einstellungen* ACME"Eigene DateienBelimo PCTool

Air module ™ Use default

Water Globe module s cetau

VAV NIMY-D2M module

VAV Compact module Language:

VAV WRPF-M module |Eng|ish »| The new language setting becomes active
after & program restart.

Log file;

" File per week % File per month
[ Enable MP-Maonitor
Simulation/Trend

[ Ask user if trendfiles should be saved (if not check save them always).
[¥ Enable sensor reading functionality

Corc

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

—Sensor
" Mone Value
' Active [0___ 32V I 0o v
" Pagzive [850...1_6k0hm]
I 0.0 v :
¢ Passive [200...60kDhm) Tranzformation
= Switch I{Nu table> j

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).
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The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc.). (See the
"Transformation table" section in the General User Manual)

4.3 Trend recording

Trend Record [

Stop Record

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

In the PC-Tool options "General", you determine whether the trend file is
automatically saved when the recording is finished (checkbox not selected) or
whether the program should ask you. The suggested file name can be modified
before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

The Trend View radio buttons allow you to set whether the display is given in
percent of the full range (%) or in volts (V).

The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Interva I

1.0 s | Trend ] | Comment... | I1_l]l]443—20025—032—033_20050821_1 50254 _tiend.bpttnd

— Trend

= 100

ACME, NM24-MFT2 Rooml

0

80

70

60

50

40

30
20

/
/
[
/

10
0

1

L] L] | T T T T T T T T T
15:02:55 15:03:00 15:03:05 15:03:10 15:03:15 15:03:20 15:03:25 15:03:30 15:03:35 15:03:40 15:03:45 15:03:50

Time

SetPoint [%] Actual angle [%] Max Position [%] MinPosition [%]

Trend plot

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.
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If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select Tools » Options in the main menu.

Variant  Click the right mouse button on the program icon in the outline bar and select
"Options".

= PC-Tool Options

General b ain wigw
Releaze Codes Detfault tab:
P ch | configurati -
channel configuration |Serwce ﬂ

“Wwater Globe module
WAl MbY-D 20 module
Wil Compact module
Wav VRP-M module
Fire & Smoke module
EPIM miodule

Cancel

Dialog for basic settings (Air module)
Select "Air module” on the left.

Using the combo box "Default tab", you can select the index tab you want to open
by default when starting the program PC-Tool.
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For fire damper actuators

User Manual
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1 Introduction

The "Fire & Smoke module" user manual describes the detail area [D] of the fire
& smoke module. The documentation is structured according to the three tabs
"Service", "Configuration” and "Simulation".
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2 Service

2.1 Displaying settings

The "Service" tab gives an overview of the current actuator settings.

= = = = = = q, P
Service ‘Conflguratlonl ~. Simulation
Actual settings
Test
Nominalrange 36° adapted
Runningtime 140s
Adaption
SwitchS1 10°

(10%)
(90%)

SwitchS2 86°

Minimal adaptionrange 20° (19%)

Damper free runningtest 5°/7s (10°/7s]
Actuator information

Firmware 0:0027 [0x04)
Configtable ID 0x0032

Datalog

Operatingtime 11748h
Activetime 20h

Messages

Messages

Damper free running test

Reset Messages

"Service" tab for BF-TopLine fire damper actuators

No settings are displayed for motorization solutions with conventional fire damper

actuators and a BKN230-24-1MP gateway. Please refer to the actuator data

sheets for more information.

Meaning of the settings

Nominal range

Range of rotation within the mechanical end stops

Running time

Time needed to cover the full range of rotation

Switch S1

Switching point for the safety position (in ° and %)

Switch S2

Switching point for the operating position (in ° and %)

Minimal adaption range

Safety limit to prevent adaptations if dampers are
blocked (in ° and %)

Damper free running test

Values for the automatic test in the operating posi-
tion (values for 180° types in parentheses)

Firmware

Software version installed on the actuator

Config table ID

Identifies the configuration table

Operating time

Number of hours for which the actuator was con-
nected to the power supply
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Active time Number of hours for which the actuator was me-
chanically in motion and connected to the power

supply

2.2 Damper free running test

2.3 Adaptation

The damper free running test checks the actuator's ability to turn from the operat-
ing position toward the safety position. Only the configured range is tested, to
prevent complete closure of the damper. The test is repeated after 24 hours.

The damper free running test is suitable for all applications in which the ventila-
tion system is not allowed to be switched off in order to carry out a full damper
test.

Click the "Damper free running test" button on the "Service" tab to start the test
manually.

The damper must be in the operating position and the damper free running test
must not be deactivated.

Adaptation is when the actuator determines the 0% ... 100% range by approach-
ing the mechanical end stops.

Click the "Adaption" button on the "Service" tab.

The progress of the adaptation is displayed in the status bar. The actuator starts
by moving into the safety position, then approaches the stop in the operating po-
sition. The maximum angle of rotation reached is stored in the actuator.

The absolute values for switching points S1 and S2 are then recalculated.

It is important to ensure that the damper blade reaches the mechanical end stops
during the adaptation (visual monitoring of the damper).
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2.4 Function test

Test progress:

- Plausibility test

- Messages deleted
- Actuator closes Abort Test
- Actuator opens

The function test checks the opening and closing of the actuator.

The actuator starts by moving into the safety position, then approaches the oper-
ating position.

Click the "Test" button on the "Service" tab. The standard display is hidden by the
test window.

Current position:

224%  21°

Test state:
Testrunning

Test report:
==
~
EBelimo Testreport
Project: Standard
Company: BELIMO
Date: 14.08.2008
Time: 10:37
Type: BFZ4TL-T-8T
OEM: BFZ4TL-T-8T
Position: Eld &, Floor 6
Serialnumber: 00515-00005-104-100
User ID: Mya
List of error messages before Testrun:
- Mechanical overload
Test activities:
1. Plausibility test
Bi

Test progress and test report display

Click the "Start test" button.
The progress and the current position are continuously displayed.

The test report contains

Information on the project,

the actuator ID,

a list of error messages pending before the start of the test,
the test steps and the test result, and

the current actuator settings.

If the test reports an invalid actuator configuration, switch to the "Configuration”
tab after ending the test. All values that are not permitted are marked there by a
flashing exclamation point.

6 /17



PC-Tool V3.6 Fire & Smoke module, user manual

2.5 Deleting maintenance/error messages

4
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Any maintenance or error messages that are generated and stored by the actua-
tor are displayed on the "Service" tab.

Messages

Messages Mechanical travel increased

Reset Messages

Message display on the "Service tab"

Click "Reset messages" to delete all messages stored in the actuator.

The following messages are displayed:

Message

Description

Mechanical travel increased

Expected end stop value for top or bottom
has been overrun (adapted range)

Mechanical overload

Actuator did not reach setpoint because an
obstacle has reduced the adjustment travel

Excessive utilization

Actuator moves too often compared to the
total operating time

Safety relevant fault [Details]

Safety relevant fault in the actuator (e.g.
ambient temperature too high). Actuator
moves into the safety position

Damper test error

Damper free running test revealed an error

Duct temperature too high

Thermoelectrical tripping device has
detected a duct temperature that is too high.
Actuator moves into the safety position

Smoke detector tripped

Contact for connecting a smoke detector is
open. The actuator moves into the safety
position.

The message "Safety relevant fault" refers to an actuator fault that could interfere
with the safety function. This message cannot be deleted. The actuator must be

replaced.

7117




T
PC-Tool V3.6 Fire & Smoke module, user manual BEL'MO

3 Configuration
3.1 Basic configuration

On the "Configuration” tab, you can read the parameter values stored in the ac-
tuator, change them, and re-store them in the actuator. The valid ranges for the
parameter values are shown in parentheses next to the input fields.

Service Configuration |, Simulation‘

Designation [BF24TL-T-ST
Position |Bld &, Floor 6

Damper free running test I Deactivated L‘

Read

Write

Store tofile...

"Configuration” tab

Actuator identification®

Designation Any 16 characters

Position Any 16 characters

Damper free running test

Deactivated Automatic test function deactivated
5°/7 s (10°/7 s) A damper free running test is carried out every 24 hours
10°/10 s (20°/10 s) Yivrlr:?c)the specified test criteria (range of rotation, time

20°/20 s (40°/20 s) The values shown in parentheses apply to actuators with
a 180° angle of rotation.

The "Damper free running test" setting is not supported by the BKN230-24-1MP
gateway.

! Only characters in the Western European character set are allowed in the designation
and location (see General part).
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3.2 Advanced configuration (manufacturer view)

Additional configuration parameters (protected by a release code) are
available for fire damper manufacturers and authorized partners.

3.2.1 Settings

Service Configuration fHSimuIationI

Designation [BF24TL-T-5T

Position |Bld &, Floor 6

D amper free running test | Deactivated

OEM Extension

|

Nominalrange l adapted

SwitchS1 10 *(1..76%)
SwitchS52 86 *(20.94%)

Load parameter file (F2)

Program (F9)

Bl
Read
10 % ‘
90 %

Store tofile... ‘

IBF-T op DmpType 1.bptpar _1_]

[V with adaption

State of programming ¢ o.k.

"Configuration" tab with manufacturer view

The following additional settings are possible:

Nominal range (rotation angle)

Adapted

Range of rotation is determined by the fire damper's me-
chanical end stops (adaptation)

Programmed

Rotation angle range can be selected within the limits
defined by the maximum nominal setting range

Switching points

Switch S1

Switching point for the safety position in degrees (°); this
value is stored in the actuator as a percentage (%) and
recalculated if the range (angle of rotation) is changed

Switch S2

Switching point for the operating position in degrees (°);
this value is stored in the actuator as a percentage (%)
and recalculated if the range (angle of rotation) is changed

Click the "Read" button to reload the actuator data.

9 /17




T
PC-Tool V3.6 Fire & Smoke module, user manual BEL' MO

3.2.2 Program

Alternative

[V with adaption

Click the "Program" button to store the new settings in the actuator.

Alternatively, you can press function key F9.

The rotation angle range of the actuator is normally determined by adaptation
(Range: Adapted). If the "With adaption" checkbox is selected, the final pro-
gramming step is to start the adaptation.

If the actuator has already been adapted and you simply want to change a set-
ting, this checkbox can be deselected.

The programming status is indicated by a traffic light (yellow, green, red) and an
explanatory text.

o @

Programming sequence:

® Connect the actuator

@ Set the parameters
® Press "Program" (F9)

...Wait until programming has finished (including adaptation)...

®

Check the programming status

©

Print labels (optional)

® Remove the actuator

For factory programming, refer to Section 3.2.4

3.2.3 Parameter file

Alternative

The fixed configuration settings for each damper type can be saved to a parame-
ter file to speed up the programming of several actuators.

The respective input fields will have a yellow background when you load these
values by clicking the "Load parameter file (F2)" button.

Alternatively, you can press function key F2.

The individual values (e.g. Position) can be changed before you start programming.

10 /17



PC-Tool V3.6 Fire & Smoke module, user manual

Example:

4
BELIMO

// BELIMO PC-Tool

// Company: Damper Manufacturer XY

//

OEMString

PositionString

MP Set Switch

MP Set Operating Range

MP Set Extended Functions
MinMaxOperatingRange

; Product XY ;

; 1000; 9000;
; 0;
; 11;
H 8800; 9200;

The easiest way to create a parameter file is to select the required settings in PC-
Tool, then save them with "Store to file". The file can be subsequently modified in
a text editor program (e.g. Notepad).

Keywords
OEMString Designation, any 16 characters
PositionString Position, any 16 characters

MP Set Switch

Switching points S1 and S2 in percent with two dec-
imal places (1000 - 10.00%)

MP Set Operating Range

Programmed range (angle of rotation) in degrees
with two decimal places (9000 - 90.00°);
0 corresponds to the adapted range

MP Set Extended Functions

Extended functions, possible values:

0: Damper free running test deactivated

11: Damper free running test 5°/7 s (10°/7 s)

26: Damper free running test 10°/10 s (20°/10 s)
42: Damper free running test 20°/20 s (40°/20 s)

MinMaxOperatingRange

Limit values (angle of rotation) after programming
(adaptation) in degrees with two decimal places
(8800 - 88.00°)

These values are not stored in the actuator but are
used by PC-Tool to evaluate the programming sta-
tus.

After defining a parameter file, you should save it with the "Write protected" at-
tribute to prevent it from being inadvertently modified.
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3.2.4 Factory programming

Factory programming is carried out for several dampers, which is why an opti-
mized sequence is recommended.

Preparatory steps (required only once):

= Create a project

= Create parameter files (with overwrite protection)

= Create a configuration file for printing labels

Set the PC-Tool options

= MP channel settings: Scan type = "PP only"
» Fire & Smoke module: Default tab = "Configuration"
» Fire & Smoke module: Select the parameter file

Save a shortcut to the project on your desktop

The PC-Tool is opened by double-clicking the project shortcut. The project is
opened directly and a bus scan starts immediately. Only one actuator at a time is
allowed to be connected to PC-Tool. As soon as PC-Tool detects an actuator, it
scans it and automatically opens the "Configuration” tab.

Before programming a batch of dampers please make sure the right parameter
file is open and the "With adaption" checkbox is selected correctly.

Programming sequence

@

Connect the actuator

Click "Load parameter file (F2)"

Check the parameters (e.g. Position) and change them if necessary

@
®
@

Click "Program (F9)"

...Wait until programming has finished (including adaptation)...

©

Check the programming status

©

Print labels (optional)

@

Remove the actuator

The adaptation process can take a few minutes. It is therefore best to program a
group of actuators in two stages:
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= After starting the adaptation, carry out steps 1 to 4 for the other actuators (PC-
Tool does not need to be connected in order to finish the adaptation).

= Reconnect all programmed actuators when the adaptation has finished and
carry out steps 5to 7.

PC-Tool has no way of knowing whether an actuator is already programmed. You
are therefore advised to test the operating range with the narrowest possible limit
values (MinMaxOperatingRange, refer to Section 3.2.3).

13 /17



T
PC-Tool V3.6 Fire & Smoke module, user manual BEL' MO

4 Controller simulation

Open the "Simulation” tab.

Servicel Configuration ® Simulation T
Actuator
SetPoint Current position Switches
" Set Point [ & [ 14 & s100)
" Close ) s2(887
{* Dpen €3 sn
81 Self Test [
" Motor Stop [
Messages
Metasgas Reset Messages

"Simulation" tab

The "Simulation” tab allows you to simulate the controller by selecting predefined
setpoints. In addition to the setpoint and the current position, you also see the
switch positions.

The actuator's internal self-test and the damper free running test can be run in
order to diagnose a fault.

The bottom half of the window shows any messages that are pending. These
messages can be reset by clicking the button.

4.1 Actuator control

Select the setpoint definition method with the radio buttons.

= Set point: The setpoint is not defined by the program. The last stored actuator
setpoint is used.

= CLOSE: The actuator moves into the safety position.
= OPEN: The actuator moves into the operating position.

= S1: The actuator moves to switching point S1, which is used to indicate the
safety position.

= Motor stop: The actuator is stopped in the current position.

"S1" and "Motor stop" are not supported by the BKN230-24-1MP gateway.

Current position
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In addition to the setpoint, you also see the current position. Both values are
shown in degrees (°).

Switch position display

The switch positions S1 (safety position) and S2 (operating position) are visual-
ized by means of lamp icons. The switching points for S1 and S2 are configured
by the damper manufacturer.

Sn is the mechanical zero position switch for the fire damper actuator and is used
to check the end position.

An error message is generated if the actuator is unable to close the zero position
switch in the safety position. The actuator remains in the safety position until the
end position is indicated by Sn.

The zero position switch is not supported by the BKN230-24-1MP gateway.

4.2 Self-test

The self-test is an internal fire damper actuator test that checks all actuator test
functions over the full range of rotation.

In the first test step, all stored messages are deleted. If a safety-relevant fault is
still present (e.g. if a duct temperature is too high), it cannot be deleted and will
cause the self-test to be canceled.

Click the "Self-test" button to start the test.

If the setpoint definition method selected for the actuator is CLOSE, the self-test
is stored in the actuator but does not start. The test is not run until you change
the setpoint definition to OPEN or S1.

4.3 Damper free running test

The damper free running test is described in Section 2.2.

Click the "Damper free running test" button to start the test manually. The damper
must be in the operating position.
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5 PC-Tool options

Alternative

Select Tools » PC-Tool options in the main menu.

Click the program icon in the outline bar with the right mouse button and select
PC-Tool options.

Select "Fire & Smoke module" from the list on the left.

5.1 Basic options

%4 PC-Tool Options @

General

Air module

Release Codes
MP channel configuration

Water Globe module
Wl NMY-D2M module
Wal Compact module
WAy VRP-M module

Fire & Smoke module

Main view
Default tab:

[ Service _:_|

Cancel

Dialog for basic settings (fire protection module)

Depending on the most frequent usage of the program’s PC-Tool, use the “De-
fault tab” combobox to select which tab will open by default when the program is

started.
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Additional options (protected by a release code) are available for fire damper

manufacturers and authorized partners.

%4 PC-Tool Options @

General Main view

Release Codes Default tab:

ritj nf;‘;;}ge' configuration |Conliguration .ll
Water Globe module After write -

WVay NMV-D2M module

VAY Compact module IV Start adaption after write

VAV VRP-M module

| Fire & Smoke module Parameter file -

lc: “daten\Belimo\PCT ool\BF-Top Produktion\parameter files\OEM Dampe I:I

oK Cancel I

Advanced settings dialog (fire protection module)

Start adaption after write

This value determines the basic setting of the "With adaption" option on the "Con-

figuration" tab.

Parameter file

The specified file is selected by default as the "Parameter file" whenever the

"Configuration" tab is opened.
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1 Introduction

The VAV module user manual describes the detail area [D] of the module for
VAV-Compact controllers. The documentation is divided according to the three
index tabs "Service", "Configuration" and "Simulation".

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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2 Service

2.1 Displaying settings

The Service tab gives an overview of the current settings of the VAV-Compact
controller.

J.- L‘
SEWIce\Conﬁguration L, Simulation | ﬁ .E\éi

Actual settings Test
Control type VAV-CAY
Control functionY DC 2-10Y
Sensitivity

Adaption

Synchronization

Nominal range 55° adapted
Calibration value
Volumetnc flow sethng "/nom: 600 m3/h Vma: 600 m3h Vmin: 0 m3'h Vimid: 300 m3'h

Direction of rolalion cw é‘:;ox
Synchronization at Y=[0%
Torgque 100%
Bus fail position Min / %'min
Power ON Mo action
Manual button Jonce] Adaption

CAV feature Standard

Actuator information

Firmware (x3020 (023)
Configtable ID 0x1026

Datalog
Operating ime 207Zh
Active ime Zh
Stop & Goratio 0%
Messages

Messages
Reset Messages

Service tab for full-rotation VAV controllers

The general part of this manual describes how you can print out the controller
parameters [Section 3.6.2.] or delete maintenance and fault messages [Section
3.6.3].

For linear actuators the stroke is displayed instead of the angle of rotation, and
the torque instead of the positioning force.

Mominal mnge 55 mm programmed
Calibration value
Volumetnc flow setfing “nom: 0 m3/h Vmax: 0 m3th

Direction of stroke up ﬁ{;m:{ﬂ
Synchronization at =03

Force 100%

Service tab for linear actuators (excerpt)
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Control function

VAV-CAV (volume control equipment) or open loop
operation (operation with external VAV controller, actuator
and sensor function)

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control signal (only for control function "Open Loop")

Feedback U5

Type of feedback signal (conventional operation)

Range Position range within the mechanical
limits
Conductance Box-specific parameter, set by the manufacturer

Volumetric flow
settings

Operating volumetric flow settings: V'nom / V'max / V'min /
V'mid
(only V'nom in open loop operation)

Direction of rotation

Clockwise/counterclockwise opening dampers (for full-
rotation actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque

Actuating force

In percent of maximum positioning force (for linear
actuators)

Behavior in the event of
bus failure

Behavior in the event of a communication failure

Power ON

Behavior when system is switched on
or after voltage interruption

Manual button [once]

Function when gearing latch button is pressed

CAV function

Mechanical stops: Standard or compatible with NMV-D2M

Firmware

Software version of the VAV-Compact

Config table ID

Identification of the configuration table of the VAV-
Compact

Operating time

Number of hours during which the actuator was connected
to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates unstable control
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2.2 Convert units for volumetric flow

2.3 Adaptation

Select Tools » PC-Tool options... in the main menu.

Click the "VAV-Compact module" on the left.

With the Volume display combobox, you determine the physical units for the
volumetric flow

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute).

This setting is for all displays, printouts, labels and writing to the log file [see
General part of this manual].

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

To start, click the "Adaptation” button on the Service tab.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop for a completely opened damper.

The actuators can be configured so that when the supply voltage is switched on
the adaptation is automatically triggered.

The adaptation can be blocked in certain actuators.

2.4 Synchronization

Variant

In the case of synchronization, a mechanical limit is approached in order to
calibrate the position calculation.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or when the damper is completely opened (100%).

To start, click the "Synchronization” button on the Service tab.

You can also trigger the synchronization directly on the actuator by pressing the
gearing latch button.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop where damper is completely opened.

The actuators can be configured so that when the system is switched on, the
synchronization is automatically triggered.

The synchronization can be blocked in certain actuators.
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2.5 Function test

The function test checks for opening and closing of the damper.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the range is set to "adapted”, movement takes place
to the other stop; with "programmed"”, on the other hand, to the programmed
range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

Test progress: Current pozition:
- 5 Start Test

- Plauzablility test
- Meszages deleted
- Achuator closes
- Actuator opens
- Te&repmt completed Test successhu

Test state:

Cloze Test

Test repart;
Testprojekt V.3 1_2 3 WMV-D2-MP_005471-30002-146-099_200802271_1258_testeport = &

[ -
Belimo Testreport

Project: Testprojekt W 3 1 2 3
Compaty: EBelimo

Date: zl.0z.Z00&

Time: lz: 58

Type: NMV-Dz-MP
Designation: HNMYV-DE-MP

Tosition: VAW 1

Serialrmmber: 00541-20002-146-0323
TUser ID: oo

List of error messages before Testrun:

Test activities:

1. Plausahlility test
2. Messages deleted

Display of test progress and test report

Click the Start test button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the VAV-Compact controller,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current controller settings.
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If the test reports an invalid controller configuration, change to the "Configuration"
tab after ending the test. The values that are not allowed are marked with a
flashing exclamation point.

You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the Close Test button. The program asks whether you
want to save an unsaved test report now.

Save testreport? [%|

\:{/ Would wou like to save the testrepart?

Ja | Mein |

If you cancel the test early, no test report is created.
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3 Configuration

In the "Configuration" box, parameter values can be read out from the VAV-
Compact controller, changed and stored in a text file. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

. F ]
Service Configuration |, Simulation ‘“’}ﬂ
Designation |ABCJ"D1 - Size250
Position |Floor 1b
V'nom V'min V'max V'mid
600 m3h 0 m3h 600 m3h 300 m3h
v Shut-off oper. 0..600 m3'h 180..600 m3/h 0..600 m3h
[ 0= | 100 % Read
Control type |VAV-CAV ~|  Mode 010V & 210V Wiite
) ) ) él\r: " cow
Direction of rolaion (g3 0% @ ooy Store tofile...
Reduce rF
Angle of rotabion |ada|:ded j | o5 °
Start Stop
Control signal Y [0OC 2-10V R
Feedback US
Bus fail posifion lm CAVfeature |Standard =
Sensitivity
Synchronizabon at |v=0% - Power ON |N|:| action j
Torgue |100 - | % Gear release button |Map1inn

"Configuration" tab for full-rotation VAV controllers

The extended input boxes in the bottom area become visible when you click
"More".

For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

= . e up
Direction of stroke100% £¢|  ~ o

Reduce Y

Stroke |programmed ~|| 95 mm(30.95mm)

"Configuration” tab for linear actuators (excerpt)
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Designation

16 characters of any text

Position

16 characters of any text

Volumetric flow, nominal

V'nom

Nominal volumetric flow (is set by the manufacturer of the

VAV box)

Volumetric flow range for control function "VAV-CAV"

V'min

Lower limit of operating volumetric flow setting

V'max

Upper limit of operating volumetric flow setting

V'mid

CAV level between V'min and V'max

Shut-off device

sets V'min permanently to 0 m3/h
(shut-off operation — closed damper)

You can convert the physical units for the volumetric flow via Tools » PC-Tool
options in the main menu [see Section 2.2.].

In the options, you can also define whether the input of the volumetric flow for
V'min and V'max in percent is possible.

An existing value for V'mid is automatically adapted when V'min and V'Max are

entered: If you enter V'min, V'mid is always larger than or equal to this input

value. If you enter V'max on the other hand, V'mid is always less than or equal to

this value.

Control function

VAV-CAV

Constant (CAV) or variable (VAV)
volume control

Open loop

Operation with external VAV controller (actuator and
sensor function)

Mode (positioning signal Y / feedback U5)

Sets positioning signal Y =0 ... 10V,
feedback U5 = volumetric flow, 0 ... 10 V

Sets positioning signal Y =2 ... 10 V,
feedback U5 = volumetric flow, 2 ... 10 V

0..10V
2...10V
others

Positioning signal Y and feedback U5 are defined
separately
(see below)

! Only characters from the Western European character set are permitted for
"Description" and "Position" (see General part, table in Section 4.3.3).
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Control signal Y
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0..10V Fixed operatingrange 0 ... 10V
2...10V Fixed operatingrange 2 ... 10V
Variable Start (Y=0%) 0...8V

Stop (Y=100%) 4 ... 32 V
Range between start and stop at least 2 V

Feedback U5 (only active when the actuator address is set to PP)

Damper position

Damper position 0 ... 10 V

0..10V
Damper position Damper position 2 ... 10 V
2...10V

Damper position
variable

Feedback, damper position
Start0...8.0V/Stop2...100V
Range between start and stop at least 2 V

Volumetric flow

Feedback, volumetric flow

0...10V 0...100% V'nom=0...10V

Volumetric flow Feedback, volumetric flow

2...10V 0...100% Vnom=2...10V

Volumetric flow Feedback, volumetric flow 0 ... 100% V'nom
variable Start0...80V/Stop2...10.0V

Range between start and stop at least 2 V

Direction of rotation (for full-rotation actuators)

cw

Damper opening in the clockwise direction

ccw

Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)
down Downward-opening damper

Range (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal setting
range of the actuator

Behavior in the event of bus failure

Last setpoint

Volumetric flow according to the last received setpoint
from the MP master

Open Move to full angle of rotation/stroke (100%)
Close Move to zero stop

Min / V'min V'min volume

Max / V'max V'max volume
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Sensitivity (for "open loop" control function only)

Normal Normal response sensitivity and reversal hysteresis
(values depend on the actuator type)

reduced Reduced response sensitivity and increased
reversal hysteresis (values depend on the actuator type)

Synchronization at

Y =0% Approach of mechanical limit at zero stop
(damper closed)

Y = 100% Approach of the mechanical limit with damper
completely opened

Torque (for full-rotation actuators) / Positioning force (for linear actuators)

25% ... 100% Can be set in increments of 25%. 100% corresponds to
the

maximum torque / the maximum positioning force for the
actuator type (see nameplate)

CAV function
Standard Mechanical stops:
e Damper closed
e V'min
e V'max
e Damper open

NVD-D2M compatible | The CAV levels correspond to the predecessors

NVD-D2M:
e Damper closed
e V'min
e V'mid
e V'max
e Damper open

Power ON
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Nothing (This option is not available for actuators of the "TOP"

performance class. When switched on, they must always
be adapted or synchronized)

Gearing latch

Synchronization (fix for VAV-Compact actuators)

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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3.2 Seal bit

In each actuator, volumetric flow settings are pre-programmed and are protected
with an electronic seal, the so-called "seal bit".

Symbol for intact seal bit

As soon as the value V'min, V'mid or V'max is changed on the system, the seal
bit is "broken". In this case, the status screen no longer displays the symbol for
the seal bit.

The specified values from the manufacturer can be reactivated at any time with
the function "Resetting to basic OEM settings ..." (see below). The seal bit
remains broken, however.

3.3 Reset to basic manufacturer settings

8|

Variant

In order to reactivate the values for V'min, V'max and V'mid pre-programmed by
the manufacturer, select File » Reset to basic OEM settings... in the main menu.

You can also trigger this function with the F6 function key or by clicking on the
"Reset to basic OEM settings..." icon on the toolbar.

13 /20



T
PC-Tool V3.6 VAV-Compact module, user manual BEL'MO

4 Controller simulation

Go to the "Simulation" tab.

:’.i

{ gt

Service] Configuration & Simulation

Actuator . Sensor
~ e |Sel pum; |Aclual f;m |D.=.|m|mlz % Mone Value
J J  Active (0_..32V) =
- o ([ [ w4
" Passive [850...1_6k0hm] ---
e e v =
~ _ i
r i Active override step: Mn /Y mn Passive (200...60k0hm) Transformation
Test B Testfie |Tesllaul1_hptts ﬂ £ Switch | J
Interval 50 s Trend Record ] Comment... |2-HP_VA‘I.!' 1_00541-30002-146-099_20060221_133044_trend_bpttm
Trend
Testprojekt_¥_3 1_2_3 NMVY-D2MP VAV 1
4 - 120
m3/h 450 i K4
400 100
] /1""‘&..__ |
350 L
300 ’/,#” - 80
2504 - 6o
200 Do
- -q-"""-h.._
1504 SRR i) NS Sy S SR Jap g . S R |
1004 _,.-/ %‘"“-«\_\ - 20
50 ‘/" il
u T L] L} L] L} L] T T T u
13:30:45 13:30:46 13:30:47 13:30:48 13:30:49 13:30:50 13:30:51 133052 133053
Time
Setpoint [m3/h] M ax setting [m3/h] Min setting [m3/h]

¥olumetric Alow [m3/h]

Lower control limit [m3/h] Damper poszition [¥]

"Simulation” tab for VAV controllers

The controller simulation is influenced when the actuator is currently carrying out
an adaptation or synchronization. The function "Motor stop" overrides a running
adaption or synchronization.
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4.1 Actuator control

4.2 Test

Select the type of setpoint definition with the radio buttons.
= Setpoint Y (only available in PP mode): Positioning signal at the connection Y.

= Setpoint Tool: The setpoint is entered in % of the volumetric flow (0%
corresponds to V'min, 100% V'max), as volumetric flow value or as positioning
signal (volts).

The control is switched off when you click Motor stop.

The following mechanical stops can be specified via radio button.
= OPEN: Damper completely opened

CLOSED: Damper completely closed

= V'nom: Nominal volumetric flow

= V'min: Volumetric flow V'min (0%)

V'max:  Volumetric flow V'max (100%)

V'mid: CAV volumetric flow V'mid

Measurement values

The following are displayed:

= The momentary volumetric flow O ... 100% of V'nom

= The actual volumetric flow in m3/h, I/s or cfm

= The feedback voltage in V (U5 signal)

= The damper opening in %

= The current angle of rotation in degrees / stroke in mm.

= An active mechanical stop is displayed as text, independent of whether they
were specified by the PC-Tool or externally (positioning signal Y).

The function test is available for the structured test of the VAV-CAV boxes.

Several consecutive commands [see 4.2.1] are defined in a test script file. When
the function is started, a trend recording is triggered.

Select test file

Select the desired script with the test file combobox.

Start test script
Click the test button * .

Important note

Before starting the actual script, the application checks whether the air
flow/system pressure is sufficient for the actuator test. (If the system pressure is
insufficient, this test can last up to 3 minutes.)
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Name of the test file

Functions

Basic_VAV_Test Max-Min 5m.bptts

V'max — 2 minutes
V'min — 2 minutes

Test VAV_0 CAV (Open-Max-Min-Close)
8m.bptts

Open — 1 ¥ minutes
V'max — 2 minutes

V'mid — 2 minutes
V'min — 2 minutes
Close — 1 % minutes

Test VAV_Max-75-50-25-Min-Close 3h.bptts Open — 2 minutes
V'max — %2 hour
SetPoint 75% — Y2 hour
SetPoint 50% — Y2 hour
SetPoint 25% — Y2 hour

V'min — % hour

Test_ VAV_Max-Auto-Min 9m.bptts V'max — 3 minutes
Auto — 3 minutes

V'min — 3 minutes

V'max — 3 minutes
Auto — 3 minutes

Test_VAV_Max-Auto 6m.bptts

Test_VAV_Max-Mid-Min 9m.bptts V'max — 3 minutes
V'mid — 3 minutes

V'min — 3 minutes

Test_VAV_Max-Min-Max[ 1_Percent ]
37m.bptts

SetPoint 100% - 2 minutes
(afterwards in steps of 1%)
SetPoint 99%...0% - every 10
seconds

SetPoint 1%...100% - every 10
seconds

Test_ VAV_Max 3m.bptts VMax — 3 minutes

Test_ VAV_Open-Max-75-50-25-Min-
Close22m.bptts

Open — 3 minutes
V'max — 3 minutes
SetPoint 75% — 3 minutes
SetPoint 50% — 3 minutes
SetPoint 25% — 3 minutes
V'min — 3 minutes
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4.3 Reading out sensors and switches

The values of integrated sensors and switches can be read out in MP mode. This function, however,
must be activated in advance in the PC-Tool options under "General". Select Tools » PC-Tool options...
in the main menu.

Felease Codes Project base path:

MP channel configuration |C:"-.Dcnkumente und Einstellungen* ACME"Eigene Dateien*Belima“PCToal
Air module [ Use default

Water Globe module s feEy

VAV NMMV-D2M module

WAV Compact module Language:

WAV VRP-M module |Eng|ish j The new language setting becomes active

after a program restart.
Log file:
" File perweek ™ File per month

[ Enable MP-Monitor

Simulation/Trend
[ Ask user if trendfiles should be saved (if not check save them always).
ble sensor reading functionality

Corc

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Sensor

" Mone Value

+ Active [0... 32¥) |02y

" Passive [850...1.6kDhm) | 02y %

" Paszszive [200.. 60k0hm) Transformabon

" Switch |<Nu table> ﬂ

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)
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4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

In the PC-Tool options "General", you determine whether the trend file is
automatically saved when the recording is finished (checkbox not selected) or
whether the program should ask you. The suggested file name can be modified
before saving the file.

Trend Recod # | Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

Stop Record [ | The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.
Acla, NMY-D2-MP. plest
. - 120
m3h, o : I %
4000+ 100
3500 -
3000+ [ 80
2500+ L 50
2000+
1500+ - 40
1000+ [ 0
500+
0- 1 T ] T 1 ] 1 ] I T ] ] 1 ] -0
11:00:00 11:00:30 11:01:00 11:01:30 11:02:00 11:02:30 11:03:00
Zeit
Sollwert [m3/h] Max Enstellung [m3/h] Min Einstellung [m3/h]
Yolumenstrom [m3/h] Untere Regelgrenze [m3/h] Klappenstellung [%]
Trend plot for "VAV-CAV" control function
Acla, NHV-D2-MP, plest
% 120 - m3/h
J - 4500
100 4000
. - 3500
80 i / - 3000
60 - 2500
- / - 2000
40 i - 1500
20 - 1000
- - 500
o+ 1 T |I T |I T 1 T 1 T 1 T 1 T 1 T 1 T 1 [l 1]
11:25:00  11:25:15 11:25:30 11:2545 11:26:00 11:26:15 11:26:30 11:26:45 11:27:00 11:27:15
Zeit
Sollwert [%] Klappenstellung [%] Yolumenstrom [m3/h] Untere Regelgrenze [m3/h]
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Trend plot for "open loop" control function

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select Tools » PC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

z PC-Tool Options

General b ain e
Release Codes Diefault tab: Flawy Lnit;
MP channel configuration

Air module | Configuration j math -

Water Globe module : . ian 15T fi
A% MMY-D2M madule [ Flows input: Option [%] fields

Yok Compact module i .
WAl YVRP-M module Calibration

Fire & Smoke module [v Set adaption after the calibration process.
EPIY module

Calibration Compact D3
[v Pazzive calibration with %'ref and ApEiref
Pretirme to Calibrate:

| 1 [5]

Cancel

Dialog for basic settings (VAV-Compact module)
Click the "VAV-Compact module" on the left.

Main window

Depending on the most common application, set which tab should be opened by
default when the program is started with the "Default tab" combobox.

With the Volume display combobox, you determine the physical units for the
volumetric flow.

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute)

If you would like to have the option of entering the volumetric flow as a
percentage, activate the "volumetric flow input: Option [%] boxes" checkbox.

Calibration options will only be used in manufacturer tool.
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1 Introduction

The "Water module" user manual describes the detail area [D] of the Water
module for globe valve actuators. The documentation is divided according to the
three tabs "Service", "Configuration" and "Simulation”.
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The Service tab gives an overview of the current settings of the actuator.

Actual seltings

Control function Y
Sensibvity

Nominal range
Running time
Stroke

Direction of stroke

Faorce
Bus fail position

Service l Configuration

DC 0510V
variable

20 mm

60s

Ma: 100%  [20mm]
Min: 0% [Omm]

ar

direct BDFF
531

100%
Last value

L, Simulation

Actuator information

Firmware 00036
Configtable ID (0084

(0=01)

Datalog
Operating ime 616h
Active ime Oh
Stop & Goratio 0%
Messages

Messages

Service tab for globe valve actuators

Meaning of the settings

6l

adapted

Mid.: 50%  [10mm]

Closing point up

MNe o
il
b

Reset Mezsages

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control function

Feedback U5

Type of feedback signal

Range

Position range within the mechanical
limits

Running time

Time needed to pass through the position range

Stroke

Programmed stroke range: Max / Mid / Min

Direction of rotation

Clockwise/counterclockwise (for full-rotation actuators)

Direction of stroke

inverted (in acc. with switch S3.1)

Plot of stroke direction to the positioning signal: Direct /

Switching point

Top / bottom (in acc. with switch S3.2)
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2.2 Adaptation

Variant

Actuating force In percent of the maximum positioning force

Behavior in the event of Behavior when communication fails

bus failure

Firmware Software version on the actuator

Config table ID Identification of the configuration table

Operating time Number of hours during which the actuator was
connected to the power supply

Active time Number of hours during which the actuator was
mechanically in motion and connected to the power
supply

Stop & Go ratio Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates an unstable control.

Running time, range, direction of rotation and stroke are not displayed on certain
actuators.

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

Click the "Adaptation™ button on the Service tab.
You can also trigger the adaptation directly on the actuator. To do this, you have

to remove the cover from the actuator. To trigger the adaptation, press the S2
button on the electronic PCB.

H1 31 s2

WY,
{Tm

[1][2] [3][4][5]

1 7 YLz Ui

Control element diagram with open linear actuator

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop at full stroke.

Next, the absolute values for a programmatically limited angle of rotation range
(minimum, mid-position, and maximum) as well as the feedback signal U5 are
recalculated and displayed.

The adaptation can be blocked in certain actuators.
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On the "Configuration” tab, you can read out parameter values from the actuator,
change them and save them back to the actuator. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

Service Configuration ©. Simulation

Designation [AVY24-MFT

Position |
Start
Control signal Y |DC 05-10V -]

Min Mid
Stroke 0 % (0..85%) 50

Running time &0 = (32 600s)

Reduce A

ar

Direction of stroke S|3;|1DFF direct

Bus fail posibon |Last value
Sensithvity |variable -

Force 100 -| %

"Configuration" tab for globe valve actuators

Actuator number?

0 mm 10 mm

Stroke |ada|:|ted j | 20 mm

g8 - 1%

Stop

Read

Max Write
100 % (15..100%)

20 mm Store to file..

Load from file___

o
OFF
S3.2 up

Designation 16 characters of any text

Position 16 characters of any text

! Only characters from the Western European character set are permitted for Description
and Position (see General part, table in Section 4.3.3).
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3-point

AC voltage, positions: Open / neutral / closed

Open / closed

DC or AC voltage, 2-point

DC 0.5-10V

(DC voltage)

fixed operating range DC 0.5-10 V

DC2-10V
modulating

(DC voltage)

fixed operating range DC 2-10 V

DC variable

Start (Y=0%) 0.5 ... 30 Volt
Stop (Y=100%) 2.5 ... 32 Volt

Range between start and stop at least 2 V

PWM 0.02-5 s

Duration of the control impulse (pulse width modulation),

fixed operating range

PWM 0.1-25.5s

Duration of the control pulse, fixed operating range

PWM 0.59-2.93 s

Duration of the control pulse, fixed operating range

PWM variable

Start (Y=0%) minimum 0.02 seconds
Stop (Y=100%) maximum 50 seconds

Feedback U5 (only active when the actuator address is set to PP)

Valve setting 2 -10V

DC voltage measurement signal, fixed range

Valve setting 0.5 -10V

DC voltage measurement signal, fixed range

Variable valve setting

DC voltage measuring signal
Start 0.5...8.0 Volt / Stop 2.5 ... 10.0 V
Range between start and stop at least 2 V

Scaling U5 (with "New Generation" actuator only)

Start

Position in percent, corresponds to the start value of the
feedback signal

Stop

Position in percent which corresponds to the stop value
of the feedback signal

Stroke

Min

Programmed lower limit of the range (cannot be changed)

Mid

Mid-position of range

Max

Programmed lower limit of the range

An existing value for Mid is automatically adapted when Max is entered: Mid is
always less than or equal to this input value.
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Examples of settings for control signal Y / feedback U5

Control signal Y: 3...8 V. min: 30%, max : 70%

Feedback U5 : 2...7 V start: 20%, stop: 90%
Position
A
Open 100%  —f-dochoobode b b Ao
1 1 1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1
- AT TTTTTTrTTImTA =
1 1 1 1 1 1 1 1
S I SO R NN P N 1 /5 SRR RN P S
1 1 1 1
1 1 1 1
— L _1__ 1 -
1 1
1 1
—— -] J—
1 1
50% 4 41 -
L
- "7
1 1
1 1 _ AN 1 _ L __1__1__1__L__ -
T T 1 1 1
1 1 1 1 1
1 d L R
1 1 1 1 1 1 1 1
1 1 1 1 1 1 1 1 1 1
B ittt i Tt A et e A e
Close 0% I I Y Y I _ Y/U5
1 T T T T [V
0 5 10
Running time
In seconds Time needed to pass through the range limited by
Min and Max (the valid range of values for the running
time depends on the actuator type and the passed-
through range)
Stroke
Adapted from the mechanical limits of certain stroke
Programmed The valid values depend on the maximum nominal
positioning range of the actuator

Stroke direction (in acc. with switch S3.1)

Direct 0% positioning signal is equivalent to 0% position
feedback.

inverted 0% positioning signal is equivalent to 100% position
feedback.
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Closing point (in acc. with switch S3.2)

top

The linear spindle is moved into the actuator with the
valve closed and the stem is moved out of the fitting.

bottom

The linear spindle is moved out of the actuator with the
valve closed and the stem is moved into the fitting.

Behavior in the event of bus failure (currently cannot be changed)

Last setpoint

Position according to control signal Y

Sensitivity
Normal
— Response sensitivity: 1%
@ Operating range
— Reversal hysteresis 2.5%

@ Operating range

Damped
— Response sensitivity: 2%

@ Operating range
— Reversal hysteresis 5%

@ Operating range

Actuating force

25% ... 100%

Can be set in increments of 25%. 100% corresponds to
the maximum positioning force for the actuator type (see
nameplate)
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4 Controller simulation

Go to the "Simulation" tab.

Service | Configuration B Simulation R !
Actuator Sensor
" Simulation off Set point Actual position + None Value
- | 40% | 400% | 95 mm (" Active (0_..32V) =
430V 520V " Passive (850_.1.6kDhm) .
- .
e © Passive(200_60kDhm) | Transformation
" Motor stop Trendview {+ & r Switch | J
Interval | 1.0 s | Stop Record ] Comment... [V24 MFT2__00626-20013-128-053_20061109_153352_trend bpttnd

Trend

acme, NV24-MFT2,

% 100
90 ]
80
70
60}
50
wl— e e
30
20
10

0} ; r ’ r r : . : . : .
15:3355 15:34:00 15:34:05 15:34:10 15:34:15  15:34:20  15:3425  15:34:30  15:34:35  15:34:40 15:34:45
Time

— Setpoint [%] Valve posibon [%] Max setting [%] Min sethng [3]

"Simulation" tab for globe valve actuators

The controller simulation is not possible while the actuator is performing an
adaptation or synchronization.

4.1 Actuator control

Select the type of setpoint definition with the radio buttons.

= Setpoint Y (only available in PP mode): Control signal at connection Y
according to selected control type (DC, PWM, open/close, 3-point).

= Setpoint Tool (not available with control type open/close or 3-point): The
setpoint is entered in % of the programmed range. 0% is the minimum, 100%
the maximum. The input values are converted and displayed in the units of the
corresponding control signal (volts or seconds).

The control is switched off when you click Motor stop. This function is not
available with the control types open/close and 3-point.
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Measurement values

During the simulation, the stroke is displayed in % of the absolute (mechanically
limited) range in millimeters and — converted according to the scale setting — as a
feedback voltage in volts.

4.2 Reading out sensors and switches

The values of sensors and switches can be read out in MP mode. This function,
however, must be activated in advance in the PC-Tool options under "General".
Select ToolsPPC-Tool options... in the main menu.

- _

Release Codes T EI IR

MP channel corfiguration |C:"'-.D0kumente und Einstellungen* ACME"Eigene DateienBelimo PCTool

Air module ™ Use default

Water Globe module se cetay

VAV NIMY-D2M module

VAV Compact module Language:

VAV VRP-M module |Eng|ish j The new language setting becomes active
after & program restart.

Log file;
" File per week % File per month

[ Enable MP-Maonitor

Simulation/Trend
[ Ask user if trendfiles should be saved (if not check save them always).
[¥ Enable sensor reading functionality

Corc

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Sensor

" Mone Value

* Active (0...32V) lﬁ\f

" Passive (850...1.6kOhm) | 03v

" Passive (200...60k0hm) Transformation

" Switch | =]

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)
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4.3 Trend recording

Trend Record

Stop Record

—Trend

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

In the PC-Tool options "General", you determine whether the trend file is
automatically saved when the recording is finished (checkbox not selected) or
whether the program should ask you. The suggested file name can be modified
before saving the file.

Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

The Trend View radio buttons allow you to set whether the display is given in
percent of the full rotation range (%) or in volts (V).

The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

Intenrdl 1.0 5 ‘ Trend [ | | Kommentar... | Iimiled_lut_cunf_l]l]llSHJ 0093-

ACHME. AM24-MFT2. Limited_lot_conf

o 100
90
80
70
60
50
40

{
!
30 !
[
' J

20
10

T
15:42:50 15:43:00 15:43:10 15:43:20 15:43:30 15:43:40
Zeit

Sollwert [%] Aktueller Winkel [¥]
Max Poszition [¥] Min Position [%]

Trend plot

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.
-
& pPC-Tool Options
General Mair view
Relzaze Codes Drefault tab:
FMP channel configuration :
&ir module | Service ﬂ

"Water Globe moduls _
W' Mhiy-D2M module After write

Wit t rmodul
W V;rg?ﬁcm;n;m: ® [ Start adaption after write

Cancel

Dialog for basic settings (Water module)

Select "Water/globe module" on the left.

Using the combobox "Default tab", you can select the index tab you want to open
by default when starting the program PC-Tool.

If an adaptation is to be performed after every programming operation, select
"Start adaption after write".
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1 Introduction

The EPIV Module User Manual describes the detail area [D] of the module for the
EPIV controller (Electronic Pressure Independent Valve, pressure-independent
flow controller). The documentation is divided up in accordance with the tabs for
"Service", "Configuration" and "Simulation".

Note
For function and wiring, see Product Information.
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2 Service

2.1 Show Settings

4
BELIMO

The Service tab offers an overview of the current settings of the EPIV controller.

Service lCuniiguratiun l Simulation

Actual settings
Control type:
Control function’y
Y-Characteristics

Feedback Us

Hominalrange
Yalve Size

Synchronization at

Power F ail-/Power off Pos.
Power Fail Delay
Power Fail Count

Bus Fail position
Power ON
Gearrelease button

Actuator informabon
Firmware

Configtable D
Datalog
Operating time
Active lime
Stop &k Go ratio
Messages
Messages

Flows Contral
DC 210
-Characterigtics on [equal percentage]

Wolumetric flow 210

b 03 b B0%
9z adapted
DM 804 3" Scaling adjusted.

Wriom: 440 /min Widaw: 352 [/min
=%

70
10z
83

Open
Mo action
Sunchronization

Y01.01.24 - 0005
0x1043

1312h
Oh
0%

Service tab for EPIV controller

T

Test

inwert 2% =Ymax

Adaption

Synchronization

In the general section of this user manual, a description is given as to how you
can print out the control parameters [chapter 3.6.2.] or delete the maintenance

and error messages [chapter 3.6.3].
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Meaning of the settings

4
BELIMO

Control function

Flow control or open loop operation

Control function Y

Type of control. If the control function is interpreted as
inverted, then this will be displayed.

Characteristic curve

The EPIV controller works with either an equal-percentage
or a linear characteristic curve.

Characteristic curve off means "linear", characteristic curve
on means "equal percentage".

Feedback U5

Type of feedback signal (conventional operation)

Nominal range

Nominal position range within the mechanical
limits

Valve size

Size of the valve; is set by Belimo. If the specified volumet-
ric flow scale with respect to the valve size has been
changed from the factory setting, then the label marked
"Scaling adjusted" will appear.

Volumetric flow settings

Operating volumetric flow settings: V'nom / V'max
(only V'nom in open loop operation)

Synchronisation at

Stop position 0% or 100%

Bus fail position

Position in the event of MP communications failure

Power ON

Behaviour/Function when switching on the device
or after a voltage interruption, respectively

Gear release button

Function when the gear release button is pressed

Firmware

Software version of the EPIV controller

Config table ID

Identification of the configuration table of the EPIV

Operating time

Number of hours during which the actuator was connected
to the supply

Active time

Number of hours during which the actuator was mechani-
cally moving and connected to the supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio (red) indicates that the control is unstable.

The following additional settings appear when EPIV is combined with Super Cap:

Power Fail-/Power off
Pos.

Actuator position after failure of the supply voltage

Power fail Delay

Time after the failure of the supply voltage and before the
actuator begins to move to the emergency setting position.

Power fail Count

Number of voltage interruptions
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2.2 Adaption

Converting units for volumetric flow

Select Tools » PC-Tool Options in the main menu.

Click on "EPIV Module" at the left.

You can determine the physical units for the volumetric flow with the Combobox
volume display

= |/min (litres per minute)

m3/h (cubic metres per hour)

I/s (litres per second)

I/h (litres per hour)

gpm (gallons per minute)

This setting applies for all displays, printouts, labels and writing into the log file
[see general section of this user manual].

With adaption, the actuator determines the available range 0% ... 100% by ap-
proaching the mechanical limits.

To start, click the "Adaption" button in the Service tab.

The progress of the adaption is displayed in the status bar. The actuator first
moves against the programmed direction to the zero end stop and then to the
end stop with complete valve opening.

The actuators can be configured in such a way that an adaption will be triggered
automatically when the supply voltage is switched on.

2.3 Synchronisation

Variant

During synchronisation, one mechanical limit is approached in order to compare
the position calculation.

Each actuator can be programmed to determine whether synchronisation is to be
carried out at the zero end stop (0%) or with full valve opening (100%).

To start, click the "Synchronisation” button in the Service tab.
You can also trigger the synchronisation directly at the actuator by pressing the
gear release button.

The progress of the synchronisation is displayed in the status bar. If synchronisa-
tion at: is set to Y=0%, the actuator will move against the programmed direction
to the zero end stop; if on the other hand synchronisation at: is set to Y=100%,
then it will move to the end stop with full valve opening.

The actuators can be configured in such a way that a synchronisation will be trig-
gered automatically when the plant is switched on.
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2.4 Function Test

The opening and closing of the valve is checked during the
function test.

The actuator first moves in accordance with the synchronisation position to the
mechanical end stop. If the range is set to "adapted", then the other end stop will
be approached; if it is set to "programmed"”, on the other hand, then it will move to
the programmed range limit.

Click on the "Test" button in the Service tab. The normal display will then be cov-
ered over by the test window.

Test progress:
- Flausibility test

- Actuator closes
- Actuator opens

Test repart;

- Messages deleted

Current position;
TTEL T4

Test state: Abort Test

i

=1=]

Project:

Comp ary:
Date:

Time:

Type:

OEM:
Position:
Serialnumber:
U=er ID:

List of error

Eelimo Testreport

3

Demo
Belimo
Z&_01_Z010
10:2&
SRE4L-CF

00951-30118-1&7-127
ooE

messages before Testrun:

Lo

Test activities:

Plansibility test

Messages deleted

Aotuator closes

Actuator opens w

Display of test progress and test report

Click on the "Start Test" button.
The progress and the current position will be displayed continuously.

The test report contains

= information concerning the project,

the identification of the EPIV controller,

a list of the error messages in effect before the start of the test,
the test steps and the test result,

the current controller settings.
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If the test reports an invalid controller configuration, switch over to the "Configura-
tion" tab after the test has been completed. There you will find the non-permitted
values marked with a flashing exclamation mark.

You can save the test report as a file by clicking on the floppy disk symbol or print
it out by pressing on the printer symbol.

End the function test by pressing on the "Close Test" button. The program will
ask whether you would now like to save a test report that has not yet been saved.

Save testreport? [%|

?l‘) Wiould you like to save the kestrepaort?
N

If you abort the test prematurely, then no test report will be compiled.
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3 Configuration

In the "Configuration" tab, you can read out the parameter values from the EPIV
controller, modify them and save them as a text file.

Service Configuration | i, Simulation

Designation |Belimo
Position |
Valve Size |DN a0/ a3 j V'nom 440 I/min - Y'max 352 I/min a0 %
a Scaling adjusted. 132440 1/min
U5 Flow Range: ooz Read
Control type |Flow Contral j Statt Stap
Write
Control zignal ¥ |D|: 210 ﬂ
¥ et 2% =Vmax ‘-Characteristice on [equal percentage] v Stare to file
Feedback US [Volmetic flow 210Y v | —1+
U5 Charactenstics on [equal percentage] W Load fromfile...
Reduce F Y
Bus fail position |Dpen ﬂ
Synchronization at |Y=U°/o j
Power Fail-/Power off Pos. 75 %
PowerFail Delay 10 &
Fower ON |N|:| actian ﬂ
Gear release button |Synchronization

"Configuration" tab for EPIV controller

The extended configuration in the lower area will become visible when you click
on "Expand".
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3.1 Settings

Controller ID*

Designation 16 characters of any text
Position 16 characters of any text
Valve size

Selection list with valve | Sets the valve size and thus also the nominal volumetric
sizes flow specified by the manufacturer (default nominal volu-
metric flow, if a release code is available, can be modified.
See below: "Display scaling").

Volumetric flow, nominal

V'nom Nominal volumetric flow (is set by the manufacturer)

Display scaling

This function is started with the button ﬂ (only if a release code is available). In
the event that the values measured internally by the EPIV actuator do not match
the externally measured values, then V'nom, and thus this display as well, can be
adjusted using this dialogue.

Display Scaling
beazured flow [external]: 386 1k
teazsured faw [internal]: 287 1/min

Y'hom 480 | rpiny

Eactory zetting | | Accept | Cancel OF. |

Measured flow [exter- | An externally measured value can be entered here. (input
nal] box)

Measured flow [inter- | Displays the value currently being measured by the EPIV
nal] controller, calculated in accordance with the V'nom that is
currently set.

V'nom Displays the current V'nom.

Factory setting | "Factory setting" function

V’nom is reset to the manufacturer's settings and written
to the actuator. The dialogue box will close.

"Accept” function

V’nom is adjusted so that external and internal measured
values match. V'nom will not be written to the actuator.

! Only characters from the Western European character set are permitted to be used for
designation and position (see general section, table chap. 4.3.3).
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The newly calculated V'nom is displayed.

Cancel |

The dialogue is closed. Any already modified V'nom will
be reset to the value prior to the call-up.

oK |

V'nom is adjusted in such a way that external and internal
measured values match. The newly calculated V'nom
value will be written into the actuator, the dialogue closes.

Volumetric flow range for the the control function "Flow control"

V'max

Upper limit of the operating volumetric flow setting (in
selected unit or in %)

The possible range is displayed under the box, it lies be-
tween 30% - 100% of V’nom.

U5 volumetric flow
range

Upper limit for the U5 volumetric flow range.
This value is typically the same as V'max[%].

The value only has an influence on the U5 feedback volt-
age value.

You can change the physical units for the volumetric flow in "Tools » PC-Tool Op-
tions" in the main menu [see chapter 2.2.].

An existing value for U5 volumetric flow range will automatically adjust itself to
the V'max when the latter is entered. On the other hand, the V'max will not
change if you change the U5 volumetric flow range yourself.

Control function

Flow control

Flow control (standard)

Open loop

Can be set only when release code is activated.

Control function Y

DCO0.5... 10V

Fixed operating range 0.5 ... 10V

DC2...10V

Fixed operating range 2 ... 10V

DC variable

Start (Y=0%) 0 ... 8V
Stop (Y=100%) 2.0 ... 32V
Range between start and stop at least 2V

Control function Y inverted

on

Inverts the control function Y
(lowest voltage = V'max)

off

Control function Y normal
(highest voltage = V’'max)

Feedback U5 (active only if actuator address is set to PP)

Volumetric flow
0.5... 10V

Volumetric flow feedback
0...100%, Vinom=0.5... 10V

Volumetric flow
2...10V

Volumetric flow feedback
0...100%, Vinom=2 ... 10V
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Volumetric flow
variable

Volumetric flow feedback 0 ... 100%, V'nom
Start 0.0 ... 8.0 volt / stop 2.0 ... 10.0V
Range between start and stop at least 2V

Y-Characteristic curve

on Characteristic curves for control function Y switched on
(input signal to volume equal percentage)
off Characteristic curves off (input signal to volume linear)

U5 Characteristic curve

on Characteristic curves for feedback U5 switched on (input
signal to volume equal percentage)
off Characteristic curves off (input signal to volume linear)

Bus fail position

Last setpoint

Volumetric flow in accordance with the last setpoint of the
MP master received

Open Open valve (100%, valve completely open)
Close Close valve
Max / V’max V’max volumetric flow

Sensitivity (only with "Open Loop" control function)

normal Normal reaction sensitivity and inversion hysteresis (val-
ues are dependent on actuator type)
reduced Reduced reaction sensitivity and increased

inversion hysteresis (values are dependent on actuator
type)

Synchronisation at

Y =0% Approaching the mechanical limit with
zero end stop (valve closed)
Y =100% Approaching the mechanical limit with full valve opening

With Power ON

Adaption

Approaching both mechanical limits and recalculation of
angle-dependent parameters

Synchronisation

Approaching one mechanical limit (in accordance with the
setting "Synchronisation at")

No action

Gear release button

Synchronisation

(preset for EPIV actuators)

12 /20



T
PC-Tool V3.6 EPIV Module User Manual BEL'MO

13 /20



T
PC-Tool V3.6 EPIV Module User Manual BEL'MO

4 Controller Simulation

Switch over to the "Simulation" tab.

Semce\ Configuration & Simulation l
Actuator -
Set t Actualflow  Val
" Simulationoff  Close | c pnuln | i uE:i | 2 \:B
" SetpointY " V'nom = = 2
+ SetpointTod  V'max | 480 I/min | 407 1/min | 5 - 4
" Motor stop 20y 88y
" Open Active override step: Vnom
Test b | Testile |Test EPIV_Max 3m.bptts ]
Interval 10 ¢ Stop Record ] Comment... |emu_SH24A—EF_I]I]951 -30118-158-127_20100128_164607_trend_bpttnd
Trend
Demo, SR24A-CF,
i b - 120 =
|Amin E50l b4
a0 - - 100
4580 L
400 . e
380 -y |
300 . s oo
250 - s |
200 - 10
150 3
100 20
a0
D T L] L] L] L] L] I:I
16:46:10 1E:4E:15 16:46:20 16:4E:25 16:46:30 16:46:35
Time
Set Point [I/min] Actual Volumetric Flov [LAmin] b am Pozition [I/min] Walve pozition 7]

"Simulation” tab for VAV controllers

Control simulation will be influenced if the actuator is currently carrying out an
adaption or a synchronisation. The "Motor Stop" function overrides any ongoing
adaption or synchronisation.
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4.1 Actuator Control (Actuator)

4.2 Test

Use the radio buttons to select the setpoint specification.
= Setpoint Y: Control function at connection Y.

= Setpoint tool: Input of the setpoint in % of the volumetric flow (100% corre-
sponds to V'max), as volumetric flow value (e.g. I/min) or as control function
(volts).

Clicking on "Motor Stop" stops the actuator.

The following override steps can be specified per radio button.
= Open: Valve completely opened

= Close: Valve completely closed

= V'nom: Nominal volumetric flow

* V'max:  Volumetric flow V’max (100%)

Measured values

The following are displayed:

= The current volumetric flow 0 ... 100% of the V'nom

= The actual flow of the volumetric flow in I/min or the selected unit
= The feedback voltage in volt (U5 signal)

= The valve opening in %

= The current angle of rotation in angular degrees

= An active override step is displayed as text, independently of whether it was
specified by the PC-Tool or externally (control function Y)

The test function is available for the structured testing of the EPIV actuator.

A number of commands which follow one another in sequence [see 4.2.1] are de-
fined in a test script file. A trend record is triggered at the start of the function.

Select test file

Select the desired scrip with the Combobox test file. Only test scripts for EPIV
modules are displayed in the Combobox.

Start test script

Click on the test » button. The tests will begin at once.
Create test script

In accordance with the templates, users can also create test scripts of their own.
File name must contain the character block "EPIV".
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4.2.1 Test scripts
The following test scripts are available as templates.

Name of the test file Functions
Test_EPIV_Max 3m.bptts V'max — 3 minutes
Test_EPIV_Max-Auto-Min 9m.bptts V'max — 3 minutes

Auto — 3 minutes

V'min — 3 minutes
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4.3 Reading out Sensors and Switches

The values from the integrated sensors and switches can be read out in MP
mode. This function must however be activated in advance under "General" in
the PC-Tool Options. Select Tools » PC-Tool Options in the main menu.

z PC-Tool Options

Folease Codes Froject base path:

MF channel configuration |"»‘-.I:h1 fz1varafch$sBelimotFCT ool J
WAY Compact Manufacturer [ | Jze default

Air module

Water Globe module

Wt MbY-D 20 module Language:

W Compact module ; » | The new language setting becomes active

WAl YRP-M module |Engllsh J after a program restart.

Fire & Smoke module :

EPI module Lag file:

" File per week * File per manth

[ Enable MP-kanitar
Simulation T rend
[ Azk uzer if trendfiles should be saved [if not check save them alwaps).

[v Enable sensor reading functionality

Cancel |

Settings for reading out sensors

A region with the sensor values will be shown on the Simulation tab, to the right
next to the actuator control.

Senszor
* Mone Yalue
" Active [0... 32V)

' -—-

e Transformahbon
" Switch

[~

Sensor display in MP mode

Use the radio buttons to select the type of the connected sensor. The value is
displayed accordingly in either volts (active), ohm (passive) or as on/off (switch).

The raw value of the sensor can still be converted into the corresponding meas-
ured variable (temperature, etc.) with the help of the transformation table (see
chapter "Transformation table" from the general user manual).
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4.4 Recording Trends

Trend Record

Stop Record

1#min 550
500
450
400
350
300
250
200
150
100

50

The progression over time of the setpoint and actual values can be displayed in a
diagram during the simulation. The values are saved to a trend file and can be
displayed again at a later date. In addition, commentary texts of one's choosing
can be added.

In the PC-Tool Options General, you define whether the trend file is saved auto-
matically when the recording is completed (checkbox not selected) or whether the
program should inquire about your preferences.

During the simulation, click on the "Trend Record" button. The display changes to
a "flat" button. Clicking once more will interrupt the recording.

According to the presettings, measured values are queried at one-second inter-
vals. You can change the querying interval in the interval input box. The permit-
ted values range from 0 to 9999 seconds, for which the value "0" means "no wait-
ing time" (querying as rapidly as possible).

If you wish to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. Shorter intervals cause too many data
points to be created and the time for plotting the curve between the queries could
become too short.

Demo, SR24A-CF,

- 120 5

- 100

. = - 80

- B0

20

Set Paint [I/rin] Actual Voluretric Flaw [1/min] F ax Pazition [lmit]

16:34:00 16:34:05 16:34:10 16:34:15 16:34:20 16:34:25
Time

Walve position [%]

Trend diagram for the control function "Flow control”
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Demo. 5R24A-CF.

5 120 E egp Hmin

10 F 500
i - 450
80 - 400
i - 350
B0 - 300
i - 250
a0 / . e 200
| e ——— 150
20 e - 100

] ________._-———-—-—__"—_—___ / [ 5

I ; ; i ; r r r i}
16:35:45 16:35:50 16:35:55 16:36:00 16:36:05 16:36:10 16:36:15
Tirne
Set Paint [%] Walve position [7] Actual Volurmetric Flow [I/min]

Trend diagram for the control function "Open loop"

You can use the comment button to enter a text at a defined point in time, which

is then saved in the trend file.
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5 PC-Tool Options for EPIV Module

Select Tools » PC-Tool Options in the main menu.

Variant  Right-hand mouse click on the program symbol in the overview bar and select
PC-Tool Options.

z PC-Tool Options

General b ain wigw
Releaze Codes Default tab: Fla Lt
kP channel configuration 5 I—_l
W' Compact bManufacturer Service j I/rir hd

Air module

Water Globe module

Wt MbY-D 20 module

Wiy Compact module

Wil R P module

Fire & Smaoke module

Cancel |

Dialogue for basic settings (EPIV Module)
Click on "EPIV Module" at the left.

Main window

In accordance with the most frequent usage, use the "Default Register" Com-
bobox to determine which tab is to be opened in the default settings when the
program is started up.

You can select the physical units for the volumetric flow with the Combobox vol-
ume display

= |/min (litres per minute)

m3/h (cubic metres per hour)

I/s (litres per second)

I/h (litres per hour)

gpm (gallons per minute)
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1 Actuators for VAV controllers NMV-D2M

The current program version of PC-Tool V3.x does not support this type of
actuator. If you have installed the previous version (PC-Tool 2.1), you can use
this instead.

This device is not supported bythe currentversion of PCTool.
You canuse PC-ToolV2.1towork withthis device. Run PC-Tool ¥2.1

In arder ta run PC-Tool %2.1 the current channel to the MP-bus has to be closed.
Ta continue working with this wersion of FC-Tool:
11 Close external ool

&) Choose 'Open' inthe context menu of the channel in the tree

Switch-over option for non-supported actuators

To enter the storage location of the program PC-Tool V2.1, select Tools » PC-
Tool options in the main menu. Mark the NMV-D2M module.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

= PC-Tool Options

EZ;;E';:; Codes PC-Tool 2.1 path zetting:
MP channel canfiguration C:\Program Files\BelimosPC-Tool_474BelimoPCT ool exe [-]
Air module
‘wfater Globe module
Wi by -D 2 module
W Compact maodule
Wak WERP-M module
Fire & Smoke module
EPI miodule

Ok Cancel

PC-Tool settings for VAV NMV-D2M module

If you have stored the start path for PC-Tool V2.1 in the options, the tool starts
automatically as soon as a VAV NVM-D2M actuator is connected. To work with
PC-Tool V3.x again, you need to disconnect the connection to the drive.

212



T
PC-Tool V3.x VAV VRP-M module, user manual BEL'MO

PC-Tool V3.x VAV VRP-M module
For VAV controller

User Manual

English

1/2


http://www.belimo.ch/CH/EN/Product/VAV/index.cfm?page=univstatic&CatNr=0403
http://www.belimo.ch/CH/EN/Product/VAV/index.cfm?page=univstatic&CatNr=0403

PC-Tool V3.x VAV VRP-M module, user manual

1 Actuators for VAV controllers VRP-M

e
BELIMO

The current version of the program (PC-Tool 3.x) does not support this type of
actuator. If you have installed the VRP-M, you can use this instead.

The VRP-M controller is not supportedby the PC-Tool V3. x
You canstart nowthe YVRP-M Tool towork with this device.

The MP-Strang gets closed during the start fram the WYRP-h Tool.
Ta continue FC-Toaol %3

1] cloze the WEF-td Taoal
21 'open' the MP-Strang (A right on the MP-Channel icon opens the menu).

Switch-over option for non-supported actuators

Run ¥RP-M Tool

To enter the storage location of the VRP-M tool, select Tools » Options in the

main menu. Mark the VAV VRP-M module.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-

Tool options.

= PC-Tool Options

General :
Felonss Codes Fath for WRP-M Tool:

X)

MP channel configuration |E:\Program FilesB elimotWRP-M-Tool\WRPMT ool exe
Aijr module

‘whater Globe module

WA MMY-DZEM module

WAY Compact module

".,.",.'l. WHEP-M module

Fire & Smoke module

EFM module

Cancel

PC-Tool settings for VAV VRP-M module

To prevent a conflict from occurring at the serial interface of the computer, the
MP-Channel is closed during the switch-over.

You have to open the MP-Channel again if you want to continue working with PC-
Tool 3.x. To do this, click the right mouse button on the MP-Channel in the
overview bar and select Open in the pop-up menu.
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1 Introduction

This user manual is directed toward Belimo system integrators and employees
who use the MP-Monitor for analyzing data traffic and for diagnosing problems on
networks with the MP-Bus.

The MP-Monitor allows system monitoring without malfunctions caused by the
PC-Tool as MP master.

All recorded values are stored with timestamp in files for later evaluation and
documentation (see Section 2.6 "Log files").
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2 Functions

2.1 Preparations

Connect the MP-Bus to a serial (COM) interface of your computer as described in
Section 3 "Wiring diagrams". If you start the MP monitor from the PC-Tool
application, the same serial interface is used which is configured for the MP-
Channel.

In order to use another serial interface, you can start the MP-Monitor outside of
PC-Tool (see below).

2.2 Start MP-Monitor

In order for you to be able to use the MP-Monitor, you must activate the
corresponding function in the PC-Tool options under "General".

Select ToolsPPC-Tool options... in the main menu.

Variant  Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

k4 PC Tool Optionen

Modul Freischattung Basispfad fur Projekte .
MP-Strang Einstellungen |C:"-.D0kumente und Einstellungen*ACMEEigene Dateien'\Belimo“PCTool
Luft-Modul [ Standardpfad verwenden

Wasser-Hub-Modul

WVAY NMVY-D2ZM-Modul

WAV Compact-Modul Sprache

VAV VRP-M-Madul U Shlte Sprach ketivi ist
Deutsch - m ausgewahlte Sprache zu aktivieren is
| Euise J ein Neustart des Programms erforderlich.

Log Datei:

{Jete =tet f Monatsdatei

[v MP-Monitor aktivieren
Simulation/Trend

-

enutzer muckirage: Trend Datei speicheren Ja/Nein?
Falls Option nicht gewahlt: Auto-Speicherung aktiv.

[ Funktion zum Sensorauslesen aktivieren.

—

Settings for activating the MP-Monitor

Then select MP-Monitor » Start MP-Monitor in the main menu or click the "Start
@ MP-Monitor" icon in the toolbar.

The PC-Tool program window is closed and a console window (DOS box) is
displayed for selecting the operating mode.
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Start MP-Monitor outside of PC-Tool

In order to use another interface other than the one configured in PC-Tool, close
the PC-Tool program. In the Explorer, change to the installation directory of PC-
Tool (default 'C:\Programme\Belimo\Belimo PC Tool V3.x")

If you start the MP-Monitor outside of PC-Tool, you have to have write
authorization in the installation directory of PC-Tool since the log files are stored
there.

Execute the program by double-clicking on the program "mp_mon.exe". A
console window (DOS box) is displayed.

Selection of the serial interface COML1...COM15
With the specified buttons '1', '2', ...'f', you can select the serial interface which is

connected with the MP-Bus.
Afterwards, the window for selecting the operating mode is displayed.
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2.3 Select operating mode

ev C:AProgrammel\Belimo\Belimo PC Tool V3. 2\mp_mon.ex

F1: MP logging on command level
F3: MP logging on application level

ESC: exit

Select the operating mode

Select the operating mode with the function key 'F1' or 'F3":

F1: Display of commands which are sent over the bus (communication
analysis)

F3: Display of positions, control and sensor values (application analysis).

2.4 Communication analysis (F1)

= CAProgrammel\Belimo\Belimo PC Tool V3.2Ymp_mon.exe

[ MP-MONITOR <u3.1> |[ comt |[ MoDE1 | m [ BACKSPACE: clear | m

In the communication analysis, commands are recorded which are sent over the
MP-Bus. The transferred data bytes and checksums are represented as
hexadecimal numbers.

CHit#> ADR D1 D2 D3 D4 DS D6 A D4 D5 D6 D?

Start window of the communication analysis

The capture of the traffic starts automatically and can be stopped by pressing the
'D' button.

Press the 'E' button to start the recording again.

You can delete the display with the Backspace key and close the program with
the Escape key.
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e C:A\Programmel\Belimo\Belimo PC Tool V3. 2\mp_mon.exe

MP-MOMITOR <U3Z.1> D: disable Ba

COMMAND CHiH> ADE D1 D2 D3 D4 DS D6 A D2 D3 D4 D5 D6 D7?
PEEK {(B@1> MP1 FB 18 @7 56 32 34 4C 4F 4E
PEEK (B@1> MPF1 FB 17 @7 55 53 28 28 28 28
PEEK (B@1> MP1 FB 1E @2 28

GET_SERIESHO (A58> MP1 72

SET_FORCED_CONTROL (814> MP1
SET_RELATIVE (A37> MP1
GET_RELATIVE (B41> MP1
GET_TRANSIT_TIME (@32> MP1
PEEK (881> MP1
PEEK (8@1> MP1
PEEK (B@1> MP1
GET_SERIESHO (a58> MP2
SET_FORCED_CONTROL (814> MP1
SET_RELATIVE <A37> MP1
GET_RELATIVE (841> MP1
GET_TRANSIT_TIME (A32> MP1
GET_SETTINGS a12> MP1
GET_SERIESHO (B58> MP3
SET_FORCED_CONTROL <Ai14> MP1
SET_RELATIVE (B37> MP1
GET_RELATIVE (841> MP1
GET_TRANSIT_TIME (832> MP1
GET_MIN_MID MAX (A59> MP1

a8
D8 88 46

¥
¥
¥
¥
¥
¥
¥
¥
¥
¥
¥
N
¥
¥
¥
¥
¥
|
¥
¥
¥
¥

Recording of communication over the MP-Bus

Meaning of the display

Column Description

COMMAND Name of the command

() Command code

ADR MP address

D1...D7 Data bytes, hexadecimal

A 'Y' = response, 'N' = no response

Additional information is contained in the log file, which is written parallel to
recording (start byte, check bytes). See also Section 2.6.1 "Communication
analysis log file".
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2.5 Application analysis (F3)

In the application analysis, the MP-Monitor does not show the individual
commands, but the configuration settings, set/actual positions, volumetric flows
for VAV actuators and sensor values.

e CAProgrammelBelimoi\Belimo PC Tool V3.2Y\mp_mon.exe

MP-MONITOR <v3.1> || comi || mopE3 BOCKSPACE: clear

Type Designation Poszition String
Act_pos Range Act_vol Unom Min_Max t_run Direction
MM State Adapt-Snyc-Test

Start window for the application analysis

The capture of the traffic starts automatically and can be stopped by pressing the
'D' button.

Press the 'E' button to start the recording again.

You can delete the display with the Backspace key and close the program with
the Escape key.

e C:\Programmel\Belimo\Belimo PC Tool V3.2\mp_mon.exe

MP-MONITOR <U3.1> _ D: disable || BACKSPACE: clear

Address

Ceries—HNo Type Designation Position String
Override Stpt Act_pos HRange Act_vol Unom Min_Max t_run Direction
Sensopr MM State Adapt-Snyc-Test

MP1

AA626-20013-128-853 MUZ24-MFT2 AVY24-MFT

NONE a 27 23.7mm @::_188:
B880881 8

MP2

HA6H?-38251-142-136 LM24A-MP

NONE a 8 ?3.8° B _188:
a]5]l5 15505 ]0)

MP3

A1234-A56783-146-897 LMU-D2-MP ABC-B1 — Size2%@ Floor 1h

NONE =, a 25.10 a:: 688m3 h @::_188: 158s cu
B8808BHA

MP47?

Recording for positions, control and sensor values

The MP-Monitor does not determine the configuration settings actively by reading
them out of the actuator, but collects the data transmitted over the MP-Bus. For
this reason, the display is built up slowly, step-by-step. If the MP-Master does not
query a piece of information, then it is also not displayed.

The recording per bus address consists of four lines. To interpret a value, see the
corresponding line and position in the table header.
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Meaning of the display
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Column Description

Address MP address of the actuator

Serial no. Serial number of the actuator

Type Actuator type

Designation Designation

Position string Position

Override Digital override via MP-Bus

Stpt Setpoint

Act_pos Actual position

Range Angle of rotation/stroke range
Act_vol Actual volumetric flow (VAV only)
Vnom Nominal volumetric flow (VAV only)
Min_Max Minimum & maximum of the range
t_run Running time

Direction Rotation/stroke direction

Sensor Sensor value

MM state see below

Adapt/Sync/Test Adaptation, synchronization or test active
MM state

Messages which are set in the actuator (bit representation)

Explanation:

If all bits are set to 0, no message is set in the actuator.

If individual bits are set to 1, this means that the corresponding messages are
active and are set in the actuator.

O

222222 T
Excessive utilisation (active if 1 is set)

Mechanical travel increased (active if 1 is set)

Mechanical overload (active if 1 is set)

Fail-Safe fail (active if 1 is set)

(Used by fire smoke dampers only)

The messages can be seen in plain text in the respective PC-Tool module.
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The log files of the MP-Monitor with the recordings are stored in the user-specific
project directory of PC-Tool (default 'C:\Documents and Settings\<Name>\My
Documents\Belimo\PCTool\<Projekt>\monitor files\).

The program stores consecutively numbered files one after the other for every
program start 'mp00.txt', 'mpO1.txt, ... etc.

2.6.1 Communication analysis log file

Date: 21.07.2008
Time: 15:51:58

15:51:59.34 MP1 SET FORCED CONTROL
15:51:59.39 Y

15:51:59.48 MP1 SET RELATIVE
15:51:59.53 Y

15:51:59.59 MP1 GET RELATIVE
15:51:59.69 Y

15:51:59.78 MP1 AD_CONVERT
15:51:59.83 Y

Each entry consists of 2 lines. The first line shows the sent command, and the
second line, marked with 'Y' shows the response.

Column Description

adr MP address

command Name of the command

(###) Command code, decima

st Start byte, hexadecimal

cc Command code, hexadecimal

d1...d7 Data bytes, hexadecimal

cl Cross parity (check byte), hexadecimal
c2 Length parity (check byte), hexadecimal
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2.6.2 Application analysis log file

This log file contains the data transmitted over the MP-Bus in chronological order
in a readable format.

21.07.2008;15:52:26.24;MP1; Type; LR24A-MP
21.07.2008;15:52:27.08;MP1;0Override; NONE
21.07.2008;15:52:27.22;MP1; Setpoint; 0;%
21.07.2008;15:52:27.38;MP1;Actual position; O
21.07.2008;15:52:27.53;MP1;Sensor Value; 0.4;V
21.07.2008;15:52:27.69;MP3;0verride; NONE
21.07.2008;15:52:27.81;MP3;Setpoint; 0;%
21.07.2008;15:52:27.99;MP3;Actual position; 10;%

)
7 ©

Each entry consists of several values which are separated from each other by
semicolons:

= Date
= Time

= Bus address

= Property
=  Value(s)
= Unit(s)

Evaluation with MS Excel

For an easy-to-understand illustration and evaluation, the text format of the MP
log files can be opened directly with the MS Office application Excel.

When opening in Excel, select "Text files (*.prn, *.txt, *.csv)" as the data type and
the semicolon (;) as the separator.

With the autofilter function (Data menu * Filter » Autofilter), comboboxes are
shown in the first lines of the tables. There you can select the bus addresses or
properties which you are interested in.

The filtered values can be displayed as a diagram, for example.
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3 Wiring diagrams

3.1 Mode switch set to "MO" (monitor)
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The mode switch on the ZIP-USB-MP must be set to "MO" if working with

the MP-Monitor.

Note:
opened in the PC-Tool.

The mode switch must first be set to "MO" before the MP-Monitor can be

Attention: ZIP-USP-MP devices off a newer generation have no switch to

toggle between MO and MA operating mode. These devices switch
automatically into Monitor mode when Monitor tool has been started.
Precondition: The Monitor tool has a Version number V3.5 or higher.

3.2 Diagram Variant 1 with ZK2-GEN cable

MP-Master
DDC Controller

Switch position ,MO* RJ11 (4/6) UK...Gateway
USB 2.0 cable V4
- BELIMO
Belimo @ & ZK2-GEN
o O Enabl:
PC-Tool |5 2/ g £ GND 24V MP
g = white = GND )z: 2: ‘Z
Q blue = not connected
ZIP-USB-MP 43 green = MP
— USB o (/)-(Z)f)
MP
@ 9 @
MP-Bus - ®
....A-MP ....A-MP ....A-MP ....A-MP ..A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
MFTR) || MFTE) || MFT@) || .MFT@) || ..MFT@) || ..MFT(2)
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3.3 Diagram Variant 2 with ZKS-MP cable
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UK24LON/EIB BELIMO
o o o| g o o0
o © ©® @ ®
LonTalk MP-Com. Power
USB 2.0 cable Switch position ,MO* a 0V 24V Y UIMP 0V 24V n.c.
g pgog Bed
- BELIVIO L]
Belimo u
PC-Tool g ) Qo 3
(o] O Initialized g ﬁ)l
A =
A ZP-USBMP  ce
— USB AC24V 1 ~
DC24V — +
ZKS-MP L
L 4 L L 2 L 2 ®
MP-Bus 4 L2 L @ 9
....A-MP ....A-MP ... A-MP ....A-MP ....A-MP
...D2-MP ...D2-MP ...D2-MP ...D2-MP ...D2-MP
.MFT(2) MFT) || .MFT@) || ..MFT@) || ..MFT(2)
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1 Introduction

The VAV D3-module user manual describes the detail area [D] of the module for
VAV-Compact D3-controllers. The documentation is divided according to the
three index tabs "Service", "Configuration" and "Simulation".

Note
For function and wiring, see VAV-Compact product information
LMV-D2-MP, NMV-D2-MP, SMV-D2-MP
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2 Service

2.1 Displaying settings
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The Service tab gives an overview of the current settings of the VAV-Compact D3
controller.

Service | Configuration | . Simulation

Actual settings

Control type Clozed-loop

Control functiony

Mominal range
Yolumetric flow setting
ApE@Y ' nom

Direction of rotation
Synchronization at

Torque

Bus fail position
Power ON
Gear release button

CAY feature

Actuator informabon

Firmware
Configtable 1D
Data log
Operating time
Active time
Stop & Go ratio
Messages

Messages

DC210%

98* adapted
Wriorn: 400 m3/h Wb aw: 400 m3/h
55 Pa

LV
o 100%
v=0%
100%

Last value
Mo action
Synchronization

old generation

W01.02.00 - 0004
0w10CD

716h
Ok
0%

Service tab for full-rotation VAV controllers

Test

Adaption

Synchronization

YMin: 0 m3sh

: Rezet Meszages

The general part of this manual describes how you can print out the controller
parameters [Section 3.6.2.] or delete maintenance and fault messages [Section

3.6.

3],

For linear actuators the stroke is displayed instead of the angle of rotation, and
the torque instead of the positioning force.

Mominal mnge 55 mm

Calibration value

Volumetnc flow setfing “nom: 0 m3/h

Direction of stroke up

Synchronization at =03

Force 100%

programmed

Vmax: 0 m3th

Toox 3]

Service tab for linear actuators (excerpt)
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Meaning of the settings
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Control function

Closed-Loop (volume control equipment) or Open- Loop
operation (operation with external VAV controller, actuator
and sensor function)

Control signal Y

Type of control

Sensitivity

Response sensitivity and reversal hysteresis of the
control signal (only for control function "Open Loop")

Feedback U5

Type of feedback signal (conventional operation)

Range Position range within the mechanical
limits
Ap@V’nom Box-specific parameter, set by the manufacturer (Ap when

V’nom is applied to the VAV-Box)

Volumetric flow
settings

Operating volumetric flow settings: V'nom / V'max / V'min
(only V'nom in open loop operation)

Direction of rotation

Clockwise/counterclockwise opening dampers (for full-
rotation actuators)

Direction of stroke

Up / down (for linear actuators)

Synchronization at

Stop position 0 % or 100 %

Torque

In percent of the maximum torque

Actuating force

In percent of maximum positioning force (for linear
actuators)

Behavior in the event of

bus failure

Behavior in the event of a communication failure

Power ON

Behavior when system is switched on
or after voltage interruption

Gear release button
[once]

Function when gearing latch button is pressed

CAV function Mechanical stops: Standard 0.1V Shut off, Standard 0.5V
Shut off, old generation (NMV-D2M)
Firmware Software version of the VAV-Compact D3

Config table ID

Identification of the configuration table of the VAV-
Compact D3

Operating time

Number of hours during which the actuator was connected
to the power supply

Active time

Number of hours during which the actuator was
mechanically in motion and connected to the power supply

Stop & Go ratio

Ratio of active time/operating time in percent. A high Stop
& Go ratio indicates unstable control
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2.2 Convert units for volumetric flow

2.3 Adaptation

Select Tools » PC-Tool options... in the main menu.

Click the "VAV-Compact module" on the left.

With the Volume display combobox, you determine the physical units for the
volumetric flow

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute).

This setting is for all displays, printouts, labels and writing to the log file [see
General part of this manual].

In the adaptation, the actuator determines the range 0% ... 100% by approaching
the mechanical limits.

To start, click the "Adaptation” button on the Service tab.

The progress of the adaptation is displayed in the status line. The actuator first
moves against the programmed direction to the zero stop and then to the end
stop for a completely opened damper.

The actuators can be configured so that when the supply voltage is switched on
the adaptation is automatically triggered.

The adaptation can be blocked in certain actuators.

2.4 Synchronization

Variant

In the case of synchronization, a mechanical limit is approached in order to
calibrate the position calculation.

For each actuator, it is possible to program whether synchronization will take
place at the zero stop (0%) or when the damper is completely opened (100%).

To start, click the "Synchronization” button on the Service tab.

You can also trigger the synchronization directly on the actuator by pressing the
gearing latch button.

The progress of the synchronization is displayed in the status line. With the
setting Synchronization at: Y=0%, the actuator moves against the programmed
direction to the zero stop, and with the setting Synchronization at: Y=100% to the
end stop where damper is completely opened.

The actuators can be configured so that when the system is switched on, the
synchronization is automatically triggered.

The synchronization can be blocked in certain actuators.
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2.5 Function test

The function test checks for opening and closing of the damper.

First of all, the drive moves to the mechanical stop according to the
synchronization position. If the range is set to "adapted”, movement takes place
to the other stop; with "programmed"”, on the other hand, to the programmed
range limit.

Click the "Test" button on the Service tab. The standard display is covered by the
test window.

Test progress: Current position: St Tost
- Plauzablility test
- Meszages deleted
- Achuator closes
- Actuator opens
- Te&repmt completed Test successhu

Test state:

Cloze Test

Test repart;
Testprojekt V.3 1_2 3 WMV-D2-MP_005471-30002-146-099_200802271_1258_testeport = &

[ -
Belimo Testreport

Project: Testprojekt W 3 1 2 3
Compaty: EBelimo

Date: zl.0z.Z00&

Time: lz: 58

Type: NMV-Dz-MP
Designation: HNMYV-DE-MP

Tosition: VAW 1

Serialrmmber: 00541-20002-146-0323
TUser ID: oo

List of error messages before Testrun:

Test activities:

1. Plausahlility test
2. Messages deleted

Display of test progress and test report

Click the Start test button.
The progress and the current position are continuously displayed.

The test report contains

= information on the project,

the identification of the VAV-Compact D3 controller,

a list of fault messages pending before the start of the test,
the test steps and the test results, and

the current controller settings.
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If the test reports an invalid controller configuration, change to the "Configuration"
tab after ending the test. The values that are not allowed are marked with a
flashing exclamation point.

You can save the test report as a file by clicking the floppy disk icon, and you can
print it with the printer icon.

End the function test with the Close Test button. The program asks whether you
want to save an unsaved test report now.

Save testreport? [%|

x:{/ Would wou like to save the testrepart?

Ja | Mein |

If you cancel the test early, no test report is created.
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3 Configuration

In the "Configuration" box, parameter values can be read out from the VAV-
Compact D3 controller, changed and stored in a text file. The valid ranges for the
parameter values are displayed in parentheses next to the input boxes.

ice |Configuration ] . Si - 7 \
Service Configuration :. Simulation ‘ m

Designation |Testhox1 [m3/h]

Puosition |LUNGU5 o] Control type |Clozeddoop j

Valurne flow
V'nom 400 m3h

Vmax A0 m3h 80..400 m3sh Bead
Vmin 0 m3h 0..400 m3/h

Write

—_— [ r "

Direction of rotation :00% o EZW Mode 010V & 210w O Store to file.
Feduce A
Angle of rotation |adapted j | 96 -
Start Stop

Control signal Y [DC 210 =]

Bus fail position |Last value ﬂ CAY feature |0Id generation j
Synchronization at |Y=D°/o ﬂ Power OM |N0 achian j

Torque |'IDD ﬂ % Gearrelease button |5_'.Jnchmnization

"Configuration" tab for full-rotation VAV controllers

The extended input boxes in the bottom area become visible when you click
"More".

For linear actuators, the stroke is displayed instead of the angle of rotation and
the stroke direction instead of the direction of rotation.

= . 0 up
Direction of stroke 100 §1 | ~ .
Reduce A
Stroke ||:un:ug|amme-:| j | 95 mm (30..35 mm)

"Configuration" tab for linear actuators (excerpt)

9/21



PC-Tool V3.6 VAV-Compact D3 module, user manual

3.1 Settings

Controller identifier*

4
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Designation

16 characters of any text

Position

16 characters of any text

Volumetric flow, nominal

V'nom

Nominal volumetric flow (is set by the manufacturer of the
VAV box)

Volumetric flow range for control function "VAV-CAV"

V'min

Lower limit of operating volumetric flow setting

V'max

Upper limit of operating volumetric flow setting

You can convert the physical units for the volumetric flow via Tools » PC-Tool
options in the main menu [see Section 2.2.].

In the options, you can also define whether the input of the volumetric flow for
V'min and V'max in percent is possible.

Control function

Closed-Loop

Constant (CAV) or variable (VAV)
volume control

Open-Loop

Operation with external VAV controller (actuator and
sensor function)

Mode (positioning signal Y / feedback U5)

0..10V

Sets positioning signal Y =0 ... 10V,
feedback U5 = volumetric flow, 0 ... 10 V

2.10V

Sets positioning signal Y =2 ... 10V,
feedback U5 = volumetric flow, 2 ... 10V

others

Positioning signal Y and feedback U5 are defined
separately
(see below)

Control signal Y

DCO...10V

Fixed operating range 0 ... 10V

DC2...10V

Fixed operatingrange 2 ... 10V

DC variable

Start (Y=0%) 0 ... 8 V
Stop (Y=100%) 4 ... 32V
Range between start and stop at least 2 V

! Only characters from the Western European character set are permitted for
"Description" and "Position" (see General part, table in Section 4.3.3).
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Feedback U5 (only active when the actuator address is set to PP)

Damper position Damper position 0 ... 10V
0...10V
Damper position Damper position 2 ... 10V
2..10V
Damper position Feedback, damper position
variable Start0...8.0V/Stop 2 ... 10.0 V
Range between start and stop at least 2 V
Volumetric flow Feedback, volumetric flow
0...10V 0...100% V'nom=0...10V
Volumetric flow Feedback, volumetric flow
2..10V 0...100% V'nom=2...10V
Volumetric flow Feedback, volumetric flow 0 ... 100% V'nom
variable Start0...8.0V/Stop2...10.0V
Range between start and stop at least 2 V
Ap, 0-10 V Feedback pressure difference Ap
0...100% V'nom=0...10V
Ap, 2-10V Feedback pressure difference Ap
0...100% V'nom=2...10V
Ap, variabel Feedback pressure difference Ap 0...100% V'nom

Start0... 8.0 Volt/ Stop 2 ... 10.0V
Range between start and stop at least 2 V

Direction of rotation (for full-rotation actuators)

cw Damper opening in the clockwise direction

ccw Damper opening in counterclockwise direction

Stroke direction (for linear actuators)

open Upward-opening damper (relative to the orientation of the
lettering on the actuator)

down Downward-opening damper

Range (for full-rotation actuators) / Stroke (for linear actuators)

Adapted from the mechanical limits of certain angle of rotation
range/stroke
Programmed Angle of rotation range (full-rotation) or stroke (linear),

the valid values depend on the maximum nominal setting
range of the actuator

Behavior in the event of bus failure

Last setpoint Volumetric flow according to the last received setpoint
from the MP master

Open Move to full angle of rotation/stroke (100%)

Close Move to zero stop

Min / V'min V'min volume

Max / V'max V'max volume
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Sensitivity (for "open |

4
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oop" control function only)

Normal Normal response sensitivity and reversal hysteresis
(values depend on the actuator type)

reduced Reduced response sensitivity and increased
reversal hysteresis (values depend on the actuator type)

Synchronization at

Y =0% Approach of mechanical limit at zero stop
(damper closed)
Y = 100% Approach of the mechanical limit with damper

completely opened

Torque (for full-rotatio

n actuators) / Positioning force (for linear actuators)

25% ... 100%

Can be set in increments of 25%. 100% corresponds to
the
maximum torque / the maximum positioning force for the

actuator type (see nameplate)

CAV function

Standard, 0.1V shut

off Y-signal (Mode=2-10V) Function
Y<01V Close
Y=Gnd Close
Y not connected (open) None (V'min)
Y = 24 VAC neg. half- Close
wave
Y =24 VAC full-wave V'max
Y = 24 VAC pos. half- Open
wave

Standard, 0.5V shut

oft Y-signal (Mode=2-10V) Function
Y<05V Close
Y=Gnd Close
Y not connected (open) Close
Y = 24 VAC neg. half- Close
wave
Y =24 VAC full-wave V'max
Y = 24 VAC pos. half- Open
wave
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old generation (NMV-
D2M) ) .
Y-signal (Mode=2-10V) Function
Y<0.1V Close
Y=Gnd Close
Y not connected (open) None (V'min)
Y =24 VAC neg. half- V'mid
wave
Y = 24 VAC full-wave V'max
Y =24 VAC pos. half- Open
wave
Power ON
Adaptation Moves to both mechanical limits and recalculates angle-
dependent parameters
Synchronization Moves to a mechanical limit (according to the setting
"Synchronization at")
Nothing (This option is not available for actuators of the "TOP"

performance class. When switched on, they must always
be adapted or synchronized)

Gear release button

Synchronization (fix for VAV-Compact D3 actuators)

Note
For function and wiring, see VAV-Compact D3 product information
LMV-D3-MP, NMV-D3-MP, SMV-D3-MP
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3.2 Seal bit

In each actuator, volumetric flow settings are pre-programmed and are protected
with an electronic seal, the so-called "seal bit".

Symbol for intact seal bit

As soon as the value V'min or V'max is changed on the system, the seal bit is
"broken". In this case, the status screen no longer displays the symbol for the
seal bit.

The specified values from the manufacturer can be reactivated at any time with
the function "Resetting to basic OEM settings ..." (see below). The seal bit
remains broken, however.

3.3 Reset to basic manufacturer settings

8|

Variant

In order to reactivate the values for V'min and V'max pre-programmed by the
manufacturer, select File * Reset to basic OEM settings... in the main menu.

You can also trigger this function with the F6 function key or by clicking on the
"Reset to basic OEM settings..." icon on the toolbar.
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4 Controller simulation

Go to the "Simulation" tab.

Service‘ Configuration # Simulation \
Actuator

" Simulationoff ' Close |SEl I_:';ml |Actui:ﬂcm | Ap = |Damp:r

" SetpointY ™ ¥'nom % % % %

" SetpointTod  © ¥'min | 0 m3/Mh | 0 Pa | LIRS

" Motor stop " Y'max 0.0 v

" Open Active overide step: Close

Test p» | Testfle |Test WAY 0 CAV [Dpen-Max-Min-Close]) 8m.bptts j

Interval 1.0 5 Stop Record ] Comment... |D3-M P_LOMGUS D_00001-60001-158-000_20110420_154608_trend. bpttnd
Trend
PCToolGUI 3.6, LMY-D3-MP. LONGUS D
m3/h 830 - 120 %
200
750 3 - 110
700 3 100
Ba0 B
£00 3 [ 9
G50 80
500 Tisseesiass = L 70
450 - 'll - &
400 N
360 'Ill “"*-...__:..____ L =0
300 i,
250 3 ! B R LS [ 40
200 'I'. \\ Py 20
150 N —— -
100 3 | . L L 20
[T lll' H""‘"‘-—-.__ E.- 10
0 : } : . : i,
15:4E:15 15:4E:20 15:46:25 15:4E:30 154635 15:4E:40
Time
Set Paint [m3/h] b aw Position [m3/h] Min Poszitian [m3/h)
Actual Walumetric Flow [m3dh] Actual angle [%] — Ap[¥]

"Simulation" tab for VAV controllers

The controller simulation is influenced when the actuator is currently carrying out
an adaptation or synchronization. The function "Motor stop" overrides a running
adaption or synchronization.

15 /21



T
PC-Tool V3.6 VAV-Compact D3 module, user manual BEL'MO

4.1 Actuator control

4.2 Test

Select the type of setpoint definition with the radio buttons.
= Setpoint Y (only available in PP mode): Positioning signal at the connection Y.

= Setpoint Tool: The setpoint is entered in % of the volumetric flow (0%
corresponds to V'min, 100% V'max), as volumetric flow value or as positioning
signal (volts).

The control is switched off when you click Motor stop.

The following mechanical stops can be specified via radio button.
= OPEN: Damper completely opened

CLOSED: Damper completely closed

= V'nom: Nominal volumetric flow

= V'min: Volumetric flow V'min (0%)

V'max:  Volumetric flow V'max (100%)

Measurement values

The following are displayed:

= The momentary volumetric flow O ... 100% of V'nom

= The actual volumetric flow in m3/h, I/s or cfm

= The feedback voltage in V (U5 signal)

= the current pressure difference (Ap) 0 ... 100% of Ap@V'nom,
= the current pressure difference (Ap) in Pa,

= The damper opening in %

= The current angle of rotation in degrees / stroke in mm.

= An active mechanical stop is displayed as text, independent of whether they
were specified by the PC-Tool or externally (positioning signal Y).

The function test is available for the structured test of the VAV-CAV boxes.

Several consecutive commands [see 4.2.1] are defined in a test script file. When
the function is started, a trend recording is triggered.

Select test file

Select the desired script with the test file combobox.

Start test script
Click the test button » .

Important note

Before starting the actual script, the application checks whether the air
flow/system pressure is sufficient for the actuator test. (If the system pressure is
insufficient, this test can last up to 3 minutes.)
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The following test scripts are available.

4
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Name of the test file

Functions

Basic_VAV_Test Max-Min 5m.bptts

V'max — 2 minutes
V'min — 2 minutes

Test VAV_0 CAV (Open-Max-Min-Close)
8m.bptts

Open — 1 ¥ minutes
V'max — 2 minutes

V'mid — 2 minutes
V'min — 2 minutes
Close — 1 % minutes

Test VAV_Max-75-50-25-Min-Close 3h.bptts Open — 2 minutes
V'max — %2 hour
SetPoint 75% — Y2 hour
SetPoint 50% — Y2 hour
SetPoint 25% — Y2 hour

V'min — % hour

Test_ VAV_Max-Auto-Min 9m.bptts V'max — 3 minutes
Auto — 3 minutes

V'min — 3 minutes

V'max — 3 minutes
Auto — 3 minutes

Test_VAV_Max-Auto 6m.bptts

Test_VAV_Max-Mid-Min 9m.bptts V'max — 3 minutes
V'mid — 3 minutes

V'min — 3 minutes

Test_VAV_Max-Min-Max[ 1_Percent ]
37m.bptts

SetPoint 100% - 2 minutes
(afterwards in steps of 1%)
SetPoint 99%...0% - every 10
seconds

SetPoint 1%...100% - every 10
seconds

Test_ VAV_Max 3m.bptts VMax — 3 minutes

Test_ VAV_Open-Max-75-50-25-Min-
Close22m.bptts

Open — 3 minutes
V'max — 3 minutes
SetPoint 75% — 3 minutes
SetPoint 50% — 3 minutes
SetPoint 25% — 3 minutes
V'min — 3 minutes
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4.3 Reading out sensors and switches

The values of integrated sensors and switches can be read out in MP mode. This function, however,
must be activated in advance in the PC-Tool options under "General". Select Tools » PC-Tool options...
in the main menu.

Felease Codes Project base path:

MP channel configuration |C:"-.Dcnkumente und Einstellungen* ACME"Eigene Dateien*Belima“PCToal
Air module [ Use default

Water Globe module s feEy

VAV NMMV-D2M module

WAV Compact module Language:

WAV VRP-M module |Eng|ish j The new language setting becomes active

after a program restart.
Log file:
" File perweek ™ File per month

[ Enable MP-Monitor

Simulation/Trend
[ Ask user if trendfiles should be saved (if not check save them always).
ble sensor reading functionality

Corc

Settings for reading out sensors

On the Simulation tab, a section with the sensor values is displayed to the right of
the actuator control.

Sensor

" Mone Value

+ Active [0... 32¥) |02y

" Passive [850...1.6kDhm) | 02y %

" Paszszive [200.. 60k0hm) Transformabon

" Switch |<Nu table> ﬂ

Sensor display in MP mode

Select the type of the connected sensor with the radio buttons. The value is either
displayed in volts (active), ohms (passive) or as on/off (switch).

The transformation table allows you to additionally convert the raw value of the
sensor into the corresponding measuring quantity (temperature etc...). (See the
"Transformation table" section in the General User Manual)
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4.4 Trend recording

During simulation, the time progress of the setpoints and actual values can be
displayed in a plot. The values are saved in a trend file and can be displayed
again at a later time. Furthermore, you can add any comment texts you would
like.

In the PC-Tool options "General", you determine whether the trend file is
automatically saved when the recording is finished (checkbox not selected) or
whether the program should ask you. The suggested file name can be modified
before saving the file.

Trend Recod # | Click the "Trend Record" button during simulation. The display changes to a "flat"
button. The recording stops when you click again.

Stop Record B  The position is queried every second by default. You can change the query
interval in an input box. The permitted values are 0 to 9999 seconds, whereby the
value 0 means "no waiting time" (query as quickly as possible).

If V'nom was set to 0 I/min, then the volumetric flows will be specified in % in the
trend display instead of in volumetric units.
PCToolGUI 3.6, LMY-D3-MP. LONGUS D
mash 830 - - 120 %
a0
750 3 - 110
700 3 100
£50 "
£00 3 [
550 &0
500 Frzssmae oo [ -5
450 4 | o B0
400 N
350 . ll _-H""h-.._ B
] l| "‘--....,______ ~ S0
300
260 3 \ T B 40
200 3 | T thi W [ 20
150 7] Il \\.. -‘.-‘-T-""""-n- o
100 3 \ B Ihr [ 20
50 : l||' e \'\_._._R_ 10
0 T t 1 ]
1534615 154620 154625 154630 154635 15:46:40
Time
Set Paint [m3ih] M ax Pozition [m3/h] tin Pogition [m3/h]

Actual Yolumetric Flow [m3/h)]

Actual angle [%] —_—fp ]

Trend plot for "Closed-Loop" control function
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PCToolGUI 3.6, LMY-D3-MP, LONGUS D

%120 = 850 f3p

T = 800

110 ] - 750

100 C 200

30 - 650

ai - GO0

- - 550

70 . '( \\ - 500

E r=e- 480

en | ‘-::\"\_‘_ - 400

. . ‘[ \ .\\H - 350

i - 300

.0 4 ‘I \\ \\ : 0

10 | e . \'\—...__ C 150

i \ ~ F 100

1] T T T T T T T : B0
_11§:43:2D 15:4B:25 15:45:30 ‘| 15:4R:35 15:43:40 15:49:45 15:4B:50 154559 i
Time
Set Point [%] Actual angle [%] —_— i %] Actual Wolumetric Flow [m3/h]

Trend plot for "Open-Loop" control function

The Comment button allows you to enter a text at a defined time and the text is
then saved in the trend file.

Override events are automatically logged with timestamp as comment.

If you want to record a trend for more than one hour (long-term trend), enter a
value of at least 2 seconds for the interval. If the interval is shorter, too many data
points will result and the time for correcting the curve between the queries can
become too short.
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5 PC-Tool options

Variant

P4 PC-Tool Options

General
Release Codes

MP channel configuration
Air module

W ater Globe module
Wy MbdY-002h module
Wi Compact module
Wt WRP-M module
Fire & Smoke module
EFI module

Select Tools » PC-Tool options... in the main menu.

Click the project in the outline bar [C] with the right mouse button and select PC-
Tool options.

b air wigw

Drefault tab: Flaw Unit;
| Configuration ﬂ ma‘h -

[ Flow input: Option [%] fields

LCalibration

[v Set adaption after the calibration process.
Calibration Compact D3

[v Pazzsive calibration with 'ref and Aperef

Pretime to Calibrate:

| 1 [5]

Cancel

Dialog for basic settings (VAV-Compact module)

Click the "VAV-Compact module" on the left.

Main window

Depending on the most common application, set which tab should be opened by
default when the program is started with the "Default tab" combobox.

With the Volume display combobox, you determine the physical units for the
volumetric flow.

= m3/h (cubic meters per hour)

= |/s (liters per second)

= cfm (cubic feet per minute)

If you would like to have the option of entering the volumetric flow as a
percentage, activate the "volumetric flow input: Option [%] boxes" checkbox.

Calibration options will only be used in manufacturer tool.
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